Examples of Using
TME 10 NetView for AIX V5 and
TME 10 NetView for Windows NT

May 1997
Examples of Using
TME 10 NetView for AIX V5 and
TME 10 NetView for Windows NT

May 1997
Take Note!

Before using this information and the product it supports, be sure to read the general information in Appendix C, "Special Notices" on page 145.

Second Edition (May 1997)

This edition applies to the most recent versions of TME 10 NetView AIX and TME 10 NetView NT.

Comments may be addressed to:
IBM Corporation, International Technical Support Organization
Dept. HZ8 Building 678
P.O. Box 12195
Research Triangle Park, NC 27709-2195

When you send information to IBM, you grant IBM a non-exclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 1996 1997. All rights reserved.
Note to U.S. Government Users — Documentation related to restricted rights — Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
## Contents

| Figures .................................................................................. | v |
| Preface .................................................................................. | vii |
| The Team That Wrote This Redbook ........................................ | vii |
| Comments Welcome ................................................................... | ix |

### Chapter 1. Introduction ......................................................... 1
1.1 NetView/AIX Current Release Support ................................ 1
   1.1.1 Tivoli PowerPoint Presentation .................................... 2
1.2 Product Overview NetView for Windows NT ........................... 9
1.3 Potential Examples .............................................................. 11

### Chapter 2. Tested Examples of TME 10 NetView for AIX V5 .......... 13
2.1 Our Scenario and Environment ............................................. 13
2.2 Installation of TME10 NetView for AIX .................................. 15
2.3 Considerations when Installing Additional Applications with NetView 17
   2.3.1 Disable Start of NetView WebServer Processes ................. 17
2.4 Enhancements to Discovery Using the netmon Seedfile ............. 17
2.5 Enhancements to the Collection Editor ................................. 18
   2.5.1 Adding a Collection from the Command Line .................... 23
2.6 Enhancements to SNMP Configuration ................................. 23
2.7 Enhancements to the RuleSet Editor ..................................... 25
2.8 NetView Events and the Tivoli Enterprise Console .................. 27
   2.8.1 NetView Events and the RuleSet Adapter ......................... 27
2.9 Receiving NetView Events at the Tivoli Enterprise Console ......... 30
   2.9.1 Configuring Rulebases for the Event Server .................... 30
   2.9.2 Configuring Event Groups and Event Sources for the Event Server 36
   2.9.3 Configuring Event Consoles and Monitoring Events .......... 36
   2.9.4 Some Useful Commands ............................................. 37
2.10 Threshold Monitoring ....................................................... 38
   2.10.1 Configuring Threshold Monitors using the Agent Policy Manager 38
   2.10.2 Configuring Threshold Monitors Using the Systems Monitor .......... 43
   2.10.3 Differences between APM Configuration and SMCFG Configuration 44
   2.10.4 Which Application Should be Used for MidLevel Manager Configuration? 45
2.11 wtdriver6 ................................................................. 45

### Chapter 3. TME 10 NetView Web Interface ............................... 47
3.1 Web Interface Usage Scenarios .......................................... 47
3.2 Starting and Navigating the Web Interface ............................ 47
3.3 NetView Processes (Status Display) ..................................... 49
3.4 Collections ......................................................................... 49
3.5 Diagnostic Applications ..................................................... 51
3.6 MIB Applications ............................................................. 56
3.7 MIB Browser ................................................................. 59
3.8 Events Display ............................................................... 61
3.9 Submaps Display ............................................................. 66

### Chapter 4. Using NetView/NT ................................................. 75
4.1 Installing NetView/NT ....................................................... 75
   4.1.1 Prerequisites ............................................................ 75
Figures

1. Summary of NetView/AIX V5 Install ............................................. 2
2. Interconnected NetView Servers .................................................. 14
3. Defining String Attributes ......................................................... 19
4. Adding Collection ‘NC’ Based on sysObjectID Attribute ................. 20
5. Adding Collection ‘Router’ Based on isIPRouter Attribute ............... 21
6. Collection Editor Window after Creating Our Collections ................. 22
7. ‘Router’ Collection Submap .......................................................... 23
8. SNMP Configuration with Collection Feature ................................... 24
9. NetView RuleSet with Two ‘Query Database Collections’ Nodes .......... 25
10. Configuring the Query Database Collection Template ..................... 26
11. An ExampleEID Enterprise ID was Added to Event Configuration ....... 28
12. Event 105 using TEC Event Class ‘NV6K_Application_Down_Event’ ... 29
13. The TEC.rs RuleSet Passes the New Event to the Dynamic Display .... 30
14. Selecting the Rulebase to be Modified ....................................... 31
15. Import of nvserverd.baroc into Rulebase ..................................... 32
16. The T/EC RuleBuilder ............................................................... 33
17. Adding a New Rule to the Ruleset ............................................... 34
18. Adding/Modifying a Simple Rule ................................................. 35
19. Adding Event Classes to a Rule .................................................. 36
20. Incoming NetView Events on the Tivoli Event Console .................... 37
21. APM Configuration Window ....................................................... 38
22. Policy Type Set to Threshold/Data Collection ................................ 39
23. Creating a New Threshold Monitor .............................................. 40
24. Node Distribution Status .......................................................... 41
25. Distribution Status Shown at the APM Configuration Window .......... 42
26. Monitor Node Status on the IP Map ............................................. 43
27. Systems Monitor Configuration V2 Application .............................. 44
28. NetView Main Menu (home) ........................................................ 48
29. Checking NetView Daemon Status .............................................. 49
30. Collections Main Menu ............................................................. 50
31. Our NetViews Collection ........................................................... 51
32. Diagnostics Main Menu ............................................................. 52
33. Ping Results .............................................................................. 53
34. DemandPoll Results ................................................................... 54
35. Display Object Information ........................................................ 55
36. Display Events for This Node ...................................................... 56
37. MIB Applications Main Menu ...................................................... 57
38. Selecting a MIB Application ........................................................ 58
39. Results of the PhysInfo MIB Application Query ............................. 59
40. MIB Browser ............................................................................. 60
41. MIB Browser with Results ........................................................... 61
42. Choosing a RuleSet on the Events Main Display ............................. 62
43. All Events ................................................................................. 63
44. All Critical Events, One Selected ................................................. 64
45. Checking Node Status After a Node Down Event ............................ 65
46. Down Node with Object Information ............................................ 66
47. Root Submap ............................................................................ 67
48. Label Link of IP Internet Icon Shows This Information .................. 68
49. Choosing Status Filter on IP Internet Submap ............................... 69
50. A Network Submap .................................................................... 70
51. A Segment Submap Showing All Nodes ........................................ 71
52. A Segment Submap Showing only Abnormal Nodes ............ 72
53. A Node Submap .................................. 73
54. A Location Submap ................................ 74
55. Setting Page Space for NetView/NT ...................... 76
56. Installing SNMP Service ................................ 77
57. SNMP Agent Configuration ................................ 78
58. SNMP Traps Configuration ........................... 80
59. SNMP Security Configuration .......................... 81
60. Starting Setup Program ............................. 82
61. TME10 NetView Menu .................................. 83
62. Starting NetView NT Daemons .......................... 84
63. Creating a Shortcut - 1 .................................. 86
64. Creating a Shortcut - 2 .................................. 87
65. The New Shortcut .................................. 88
66. GUI Started with Daemons Down ....................... 89
67. Typical IP Map .................................. 90
68. Setting General Polling Options ....................... 91
69. Setting Daemon Restart Options ....................... 93
70. Setting SNMP Options for Specific Nodes ............. 94
71. Performance Counters Provided by NetView ........... 95
72. Graphical Display of NetView Performance Counters .... 95
73. NetView NT-Supplied Applications and Utilities ....... 96
74. MIB Browser Dialog ................................ 98
75. Setting a MIB Variable .............................. 99
76. Database Summary .................................. 101
77. ovobprintf -s [selection_name] .......................... 102
78. Examining Objects Properties via the GUI ............. 103
79. NetView NT Event Browser Window ..................... 104
80. Event Details .................................. 105
81. Trap Setting .................................. 106
82. NetView/NT Trap Properties .......................... 107
83. Configuring a New Trap ................................ 107
84. Setting Event Filters ................................ 108
85. The Find Dialog Box ................................ 109
86. A List of Found Objects ................................ 110
87. Creating a SmartSet ................................ 111
88. Displaying a SmartSet ................................ 112
89. Routers and Workstations ........................... 113
90. Advanced Search ................................ 114
91. Workstation That Is a Router ......................... 115
92. wtdriver6/wteuiap6 Overview ........................ 116
93. Summary of wtdriver6/wteuiap6 Functions ............. 117
94. A Complete Example of User Commands for wtdriver6/wteuiap6 ... 121
95. Result of driver6ex.cmd ................................ 122
96. Advanced Search ................................ 123
97. Results of Advanced Search .......................... 124
98. SmartSet Based on Custom Fields ..................... 125
99. Result of ovobprintf -s Client3 ....................... 125
100. Example of User Fields in NetView/NT ............... 126
Preface

This redbook shows examples of using TME 10 NetView in various configurations and application situations on AIX and Windows NT.

The examples show how the NetView family is beginning to be merged into Tivoli TME 10 as core products. Examples of such integration are the ability to control and manage TME 10 NetView/AIX using the TME Desktop, expansion of NetView-to-Tivoli T/EC interactions, and improved ruleset processing for event correlation as well as examples of using new Web support for NetView AIX. In addition, examples of using NetView for Windows NT show how this strong addition to the TME 10 NetView set of products can be used in a Windows NT environment.

The examples are presented in a step-by-step fashion and will assist in early use of TME 10 NetView V5 and TME 10 NetView for Windows NT, as implementation of these important products contribute to an installation’s overall Tivoli/IBM systems, network, and application management strategies.

This document is based upon an early version of TME 10 NetView V5 and is planned to be updated following general release of the product.

The reader of this document is assumed to have prior exposure to NetView AIX.

The Team That Wrote This Redbook

This redbook was produced by a team of specialists from around the world working at the Systems Management and Networking ITSO Center, Raleigh.

The authors of this redbook were:

Leslie Clark, IBM USA
Peter Steinbrecher, IBM Germany
Alex Rosenbaum, Price Waterhouse LLP

The authors of the earlier version of this redbook were:

Peter Glasmacher, IBM Germany
James David, RISCmanagement

The advisors of this project were:

Dave Shogren
Paul Fearn
Stefan Uelpenich
Systems Management and Networking ITSO Center, Raleigh

Thanks to the following people for their invaluable contributions to this project:

Ute Merk, IBM Germany
Ralf Winter, IBM Germany
Vincent Fung, IBM Canada
Andre Jenie, IBM Singapore
Yaqub Bhatti, IBM Pakistan
Gonzalo Quesada, Costa Rica
Theo Winkelmann, South Africa
Emma Locke, IBM UK
Richard Hine, IBM UK

and many other residents who participated in TME 10 projects at the Systems Management and Networking ITSO Center, Raleigh.
Thanks, as well, go to:

Judith Dietz  
Jim Chou  
Brett Coley  
Richard Buckman  
Brian Tarbox  
Jeffrey Snover

and many other persons from Tivoli/IBM Austin.

Comments Welcome

Request for Feedback

Readers of this document are encouraged to feed back any information or comments regarding any of the material in this document. Please send your comments to:

Dave Shogren, Paul Fearn, or Stefan Uelpenich  
ITSO Center, Raleigh

INTERNET: shogren@vnet.ibm.com  
fearnpr@vnet.ibm.com  
stefanu@vnet.ibm.com

VNET: SHOGREN at WTSCPOK, FEARNPR at WTSCPOK, or STEFANU at WTSCPOK

or: IBM Corporation  
HZ8D/B678/D100  
Attn: Dave Shogren / Paul Fearn / Stefan Uelpenich  
Building 678 Rm D100  
1001 Winstead Dr.  
Raleigh (Cary) NC 27513

All source code referred to in this book will be available after publication of this redbook in the Redbooks Home Page at the Web site:

http://www.redbooks.com

or from within the IBM network, Anonymous FTP server at:

rsserver.itso.ral.ibm.com  
Directory: /pub/SG244898
Examples of TME 10 NetView for AIX V5 and Windows NT
Chapter 1. Introduction

This chapter summarizes features included in the latest release of TME 10 NetView, and mentions features of TME 10 NetView that were candidates for analysis at the start of this project.

Hereafter in this document, TME 10 NetView is used as a generic term for the TME 10 NetView family which exists on AIX, Windows NT, or SUN Solaris.

This project did its work on AIX and Windows NT. If the discussed matter is related to TME 10 NetView on a particular tested platform, the product will be referred to as:

- NetView/AIX as TME 10 NetView V5 for AIX
- NetView/NT as TME 10 NetView V4 for Windows NT

This document used early versions of TME 10 NetView V5 and is planned to be updated after product general release.

1.1 NetView/AIX Current Release Support

Although there are many significant features in NetView/AIX V5 worthy of mention and discussed below, two of the features come immediately to the forefront:

1. NetView/AIX V5 is the first release of NetView that is tightly coupled with the TME 10 Framework. NetView/AIX V5 is the first NetView release that is installed using TME 10 install; it is not installed using AIX installp. See Figure 1 on page 2.

Once installed, TME 10 NetView/AIX V5 may be configured and controlled using the TME 10 desktop. This means that it may be configured and controlled from any desktop within the Tivoli Management Region (TMR).

2. NetView/AIX V5 includes support for Web analysis of NetView maps.

Both of the above matters do not, at this time, apply to NetView/NT V4.
Summary of NetView Features:

The following matters are a summary from:
//http.widow.tivoli.com and search for NetView

1.1.1 Tivoli PowerPoint Presentation

This information is from:
Judith Dietz
Tivoli Systems
January 7, 1997

Agenda

Overview
  • Things to remember
  • Goals of this release
  • What’s new and exciting

New Feature Review

In-depth previews of new functions

Things to remember
  • TME 10 NetView has the best integration with systems management products
  • TME 10 NetView is architected to address the scalability issues that large customers demand
  • TME 10 NetView provides the best enterprise-wide network management solution in the industry
Goals of this release

• Cross-platform support
• TME Integration
  Make progress toward true integration of systems and network management.
• New functions
  – Continue to address scalability issues
  – Keep NetView the best in the industry

Cross-platform support

• Servers on Solaris, Digital UNIX, and NT (Intel, Digital Alpha) 1Q97, as well as AIX
  NT Versions not quite at same level (YE97)
• MLM already on HP-UX, Solaris, Digital UNIX, NT, Warp, as well as AIX

TME Integration

• Integration with TME Framework
• Installation
• Administration/configuration
• Security
• Events (T/EC)
• Relational database support (RIM)

Enhancements

• Collection Facility
• Events Subsystem
• netmon
• MLM
• Web Interface

Collection Facility: Allows users to group objects based on a set of common characteristics. Collections updated dynamically. Required for enterprise-level scalability
• Now used throughout NetView
• Polling and configuration checking times
• Data collection
• Ruleset evaluation

New features

• Wildcard support
• Regular expressions
• IP address ranges
• Command line interface
• Improved map display
• Uses ipmap symbols where possible

**Web Interface**
• Enterprise-wide access to distributed NetView servers
  From geographically dispersed sites
  Using universal thin client (Web browser)
• Currently limited to browsers supporting Java 1.0 and JavaScript 1.1
  (Netscape 3.0) Web Interface.
• Access to commonly used functions
  Status display
• View symbol status for maps
  Event display
• Live incoming event display
• Search event logs
• Diagnostic applications
• Ping, demand poll, MIB Browser, generated SNMP applications
• Provides a consistent approach to Network and Systems management
  applications
• Integrates with other TME 10 Applications
• Leverages TME 10 platform services

**TME-based Installation**
• NetView uses TME-based Admin/Config
  NetView admin/config from TME Desktop
• NetView uses TME-based security
  Maintains NetView security APIs
• Forwarding of events to the T/EC
• Use RIM for RDBMS support
• Installation of all management (network and systems) applications in an
  easy, consistent manner

**1.1.1.1 What’s New with NetView Correlation?**
• Rulesets can query the collection facility
• Additional event attributes available for event filtering
  Source, Category, Severity
• Utilize collection facility for more sophisticated automation
• More powerful and more flexible events display within NetView

**Why do you (or your customers!) care?**
• Utilize collection facility for more sophisticated automation
• More powerful and more flexible events display within NetView
**Collections Query from Ruleset**

- New Query Collections element in ruleset
- Similar to existing ruleset elements

**Demo - Collections Query:** From the main NetView pulldown:

- Create collection
  
  Tools->Collection Editor

  Call it anything you like

  Simple attribute, for example isPC=true

- Create ruleset testing event in collection
  
  Tools->Ruleset Editor

  Create ruleset

  Collection node with collection and attribute 2

- Open nvevents window for ruleset

- Generate event (or wait)

**1.1.1.2 Demo - New Event Attributes**

(This code is not complete as of Jan 4).

- Create ruleset with event attributes

- Open nvevents with dynamic window

**Caveats/Limitations**

- Must create collection first; field on panel should be editable, will be fixed in final version
- Severity, Source, Category not in initial code yet

TME 10 NetView MLM provides light-weight monitoring of network management domains. By rebranding the Systems Monitor MLM as TME 10 NetView MLM, the distributed network monitoring solution is highlighted as a core product.

   The other elements of Systems Monitor (SIA and SLM) become freely available via the Web.

- Rebranded Systems Monitor MLM as TME 10 NetView MLM
- TME-based MLM admin/config

  MLM admin/config from TME desktop

  Ported smconfig (X-based config appl)

- New features for UNIX MLM

  Thresholding may contain analysis expressions

  Vector Processing

- Uniform installation

- The images for the MLM are not ready yet.

  There are no labs, docs, demo yet...

- Discovery support for new LAN technologies
• Limited discovery
• The ability to define polling policies based on collections
• Support for ATM LAN emulation
  Ethernet (IfType = 59)
  Token Ring (IfType = 60)
• Use of the ä!ô operator in the seed file to limit discovery
• Use of collections to define netmon’s management policies
• Supports new interface types
  aflane802.3 (emulated ethernet)
• Given bus layout
  aflane802.5 (emulated token ring)
• Given ring layout
  The discovery of network nodes can now be limited by a node’s IP Address
  Done by specifying the ä!ô operator before a hostname, IP Address, or IP
  Address range in the seed file (i.e. !9.37.33.*)
  Allows the use of collections to be used when defining the management
  policies for a node including:
  Status Checking Intervals, Timeouts, Retries
  Config Check Intervals
  SNMP Community Names, Timeouts, Retries
  Done using the xnmsnmpconf dialog
• Current RDBMS database support in Netview

1.1.1.3 More About Collections
• Regular expressions can now be used in collection rules
• Two new operators:  (LIKE) and ! (NOT LIKE)
• Wildcarding for IP addresses does not use regular expressions
  Application writers can now register for events based on collection
• New API: nvCollectionAddColCallback() If an application registers for the
  same event for all collections and a specific collection, they will get the
  notification for the more specific registration
  Users can now set polling and configuration check times based on collection
  membership
• Collection membership can be tested in a ruleset node
• Data collection can be done on a collection
• Any application using the OVsnmpConf API will be able to use collections
  Users can now manipulate collections from the command line
• Collections can be created, deleted, modified, viewed, etc.
1.1.1.4 More on the Web Support

- Provides access to distributed NetView servers
  - From geographically dispersed sites
  - Using universal thin client (Web browser)
- Access to commonly used functions
  - Symbol status on submaps
  - Events
  - Diagnostics
- Status displays
  - Real-time views of symbols on maps open in read-write mode
- Event display
  - View incoming events, search logs
- Diagnostic applications
- Collections
- NetView Status
- Submaps
  - Live symbol status
    - Filter based on status
    - Read-write map must be up
    - Topology view planned
  - Symbol links to lower level submap
  - Label links to diagnostics

**Event Display Using the Web**

- View live events
  - Select ruleset to use as filter
- Show node information
- Launch MIB Browser

**Diagnostics Using the Web**

- Most common diagnostics accessible from one page
  - Ping
  - Demand poll
  - Traceroute
  - MIB Applications
  - Object Information
  - Node events
- Accessible from ovw
MIB Applications Using the Web

- Forms and tables
- Graphs in future
- Can sort by column
- Some platforms

MIB Browser on the Web

- Browse MIB of any SNMP node
- SNMP traffic from server, not browser

Object Summary on the Web

- Summary of important information
  - Object type
  - Location
  - Contact
- Launch Cooltalk session with administrator

Object Information

- All information kept by NetView
  - contents of ovwdb database entry for object
    - Organized by field type

Collections

- List collections
- View collection contents
- No map required

But no map information available

NetView Status

- View status of NetView processes
  - Ability to start/stop in future

Web Interface - Service Issues

- Check browser version and platform
  - Client field on main NetView Web page
- Verify that problem is reproducible
  - Press reload on browser to ensure problem is not due to network connection between browser and server
- Error logs kept for server
  /usr/OV/Web/httpd/logs/error_log

Examples of TME 10 NetView for AIX V5 and Windows NT
1.2 Product Overview NetView for Windows NT

*Familiar to the NetView User:* Previous NetView for AIX users will find similarities and improvements.

*Familiar to the Windows User*

- **Intuitive**
  - The award-winning network management GUI made even better in the Windows 95 environment
  - Easy to learn
  - Easy to use
    - Wizards
    - Toolbar with ToolTips
    - Context-sensitive menus
      - Never-get-lost navigation techniques
- **Robust**
- **Full industrial-strength enterprise manager**
  - Not a warmed-over port of a DOS product
    - All the critical functions for full enterprise management
    - Complete application development environment for integrating added-value management applications
  - Industry-standard APIs
  - Industry-standard integration mechanisms
- **Manage from mid-range Intel machines to multiprocessor Alpha machines**
  - Same product
  - Same UI
  - Same APIs
- **Task-Aware**
  - UI design based on extensive useability testing with network managers
    - Most frequent tasks have been streamlined
- **Easy access to LOTS of information via Property Sheets**
  - Float successive hypotheses (launch successive tests) without having to retraverse menu stacks
  - Familiar, Intuitive, Task-Aware; Network management has never been easier

**Intel Configuration Requirements:** Intel benchmarks Test Results

<table>
<thead>
<tr>
<th>RAM</th>
<th>Managed Nodes</th>
<th>Managed Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 MB</td>
<td>420</td>
<td>965</td>
</tr>
<tr>
<td>80 MB</td>
<td>2,500</td>
<td>5,750</td>
</tr>
<tr>
<td>128 MB</td>
<td>4,450</td>
<td>10,235</td>
</tr>
</tbody>
</table>
New In TME 10 NetView V5.0 for Windows NT

- Full Client/Server
- NT 4.0 support
- Removal of NutCracker
- DHCP support
- Scheduled discovery
- Summary reports
- Object collections
- ODBC based event subsystem TESS

Client Server

- Run full netview gui on client; deamons on server
- Client machines can be low end 486-66, 32-48 megs
- Third party products run unchanged
- Design Center: 30 clients on one server machine
- Common view of network, reduced network traffic
- User actions propagate to all clients
- Different than UNIX model of client/server

GUI Enhancements

- Progress bars
- Animated icons
- Windows 95 style help system
- Control specific help
- Getting started help on TipOfTheDay
- DataTips on nodes (can’t use that name). User
- Configurable popup info when cursor over node
- Mib Browser now supports bookmarks

Zoom enhancements

- Significantly faster
- Zoom-to-fit
- Increased max zoom to 15X

TESS

- New ODBC-based events system (TESS)
- Ship with a Jet database engine (INTEL only)
- Will certify SQL Server
- Significantly faster
- Easier adhoc queries
- Far better historical reporting
- Persistent notes associated with events
- Ability to acknowledge a node via an event
- Ability to assign ownership of events

SNMP Data Collector

- Supports SQL datastores
  - faster than using flat files
  - easier to analyze
new snmpdump program with filtering options

Enhancements
- more feedback on status of collections
- support for filtering in data display
- faster data display
- can export data to MS-Excel

Optimized SQL Schema

Other:
- SummaryReport; configurable high level view of network
- Scheduled discovery; specify not only how often but when new node poll and discovery poll should occur
- Discovery gui; graphical view of netmon’s ongoing status
- NT Services: automatically start on machine powerup - no user logon required

1.3 Potential Examples

The following are just some of many examples that this project discussed using at the start of its efforts. Due to time and resource constraints, all of the examples could not be pursued. The remainder of this document shows specific examples that were tested.

- Using Seed files
- wtdriver6/etc. eui example
- Collections and Collections API and wildcard
- Performance and how you can capture/look at performance
- Nways Campus Manager or other device management approaches
- Interacting with T/EC
- Interacting with Sentry
- Interacting with MLM
- NetView NT and NetView AIX co-existance and/or interactions
- ITSO’s itsodepend example
- Multiple NetViews within one TMR
- Web support -- and, non-support
  Over DIAL connection (Performance)
- Client/Server
- Events -- and T/EC
- T/EC <-> T/EC and T/EC to/from NetView/AIX and NetView/NT
- After install, what are requirements for Framework
- Host (S/390) and interaction with NetView/AIX
- Host (S/390) and interaction with NetView/NT
  No service point function on NT. What would be a recommended approach?
- MQSeries AMS module and TME
• Expand upon NetView NT and wteuiap6 (ovw API), etc.
• Expand lab/demo examples currently being worked on for inclusion in ITSO redbooks related to TME and NetView for Windows/NT.
Chapter 2. Tested Examples of TME 10 NetView for AIX V5

This chapter summarizes examples tested during this project. We were interested in exploring three aspects of NetView V5:

• New functions and features in NetView for AIX
• Using NetView with the Tivoli Management Framework and T/EC
• Using NetView without the Tivoli Management Framework

2.1 Our Scenario and Environment

Assume that a global company wants one NetView to discover and manage the US network, and another NetView to discover and manage the European network. Operators and analysts will watch the maps on their local NetView systems. However, they want to install and administer both of the NetViews from a central site, usually in the US, but occasionally from Europe as well. In addition, because of the client/server applications running on systems distributed between Europe and the US, they need to correlate events for certain devices in both networks, and in some cases take action.

The physical connections are immaterial here, but assume that the hosts rs600011, rs600023, and rs600024 are in the US, and rs600010 and rs600020 are in Europe.
AIX host rs600011

- Is the TMR server for the Tivoli Management Region ‘TMR_rs600011’
  - Runs Tivoli Management Framework Server 3.1 code
- Is a Network Management Station
  - Runs TME 10 NetView for AIX base & features code
  - Runs TME NetView Server Configuration Facility
- Is a T/EC Console
  - Runs Tivoli/Enterprise Console code

AIX host rs600010

- Is a managed node in the TMR ‘TMR_rs600011’
  - Runs Tivoli Management Framework client code
- Is a Network Management Station
  - Runs TME 10 NetView for AIX base & features code

AIX host rs600020

- Is a managed node in the TMR ‘TMR_rs600011’
  - Runs Tivoli Management Framework client code
- Is a T/EC Server
  - Runs Tivoli/Enterprise Console RDBMS code
- Is a T/EC event console
  - Runs Tivoli/Enterprise Console code
AIX host rs600020

- Is a managed node in the TMR 'TMR_rs600011'
  - Runs Tivoli Management Framework client code
- Is a T/EC Console
  - Runs Tivoli/Enterprise Console code

AIX host rs600024

- Is a managed node in the TMR 'TMR_rs600011'
  - Runs Tivoli Management Framework client code
- Is a Tivoli/Enterprise Console
  - Runs Tivoli/Enterprise Console code

All of the Tivoli and NetView components are installed on all of the nodes from the TMR server rs600011.

Along with the functions outlined above, any of the boxes can also run the Tivoli administrative desktop. Boxes rs600020 and rs600023 can only run the administrative desktop. Any admin desktop can run one or more event consoles, watching events processed by the Enterprise Console.

The rs600011 box serves as the Tivoli Management server for many other managed nodes in the US, and at least a few nodes in Europe, where there might be other Tivoli Management Regions. We will focus on activities within the single TMR. The NetView on rs600011 discovers and manages the network in the US. The NetView on rs600010 discovers and manages the network in Europe, where it is located. Both NetViews are administered from admin desktops defined to the TMR server, and those desktops may run on any managed node in the TMR. Generally, we will manage it from node rs600023 (in the US), but off-shift, an administrator in Europe may administer either NetView from rs600020.

Both NetViews forward events for certain devices (defined by a NetView Collection) to the T/EC server on rs600024 in the US. They use the NetView RuleSet adapter. The correlated events on the T/EC server can be monitored on the admin desktops on rs600020 in Europe, and rs600024 in the US, because these managed nodes also have the T/EC console application installed. Since this application is also installed on the TMR server and the T/EC server itself, admin desktops on those systems can also monitor the forwarded events.

The T/EC server (rdbms code) could have been installed along with the TMR server or NetView, or both, but we expect that it will be quite busy processing events from all of the managed nodes in the TMR, so we kept it separate.

2.2 Installation of TME10 NetView for AIX

Here are some suggestions based on our experiences installing NetView V5:

- Make sure that the TME 10 Framework has been successfully installed by running the wlsinst -ph command. This is either the TME server code, if you are going to install NetView on the TMR server itself, or the TME client code, if you are installing NetView on a managed node in the Tivoli Management Region.

- Take a backup of the TME Framework database before starting the install of NetView, and after installing each component. Backup is under the Desktop menu pull-down. If the NetView install fails, TME will not usually notice. To
reinstall NetView, you may have to restore the TME database to the state it was in before the attempted install. Although backups are taken with the GUI, restores are done with the `wlsbackup -r <bkupname>` command.

- The diskspace requirements for the installed NetView product seem to be the same as they were for NetView V4: namely, 150MB for the base and features' components, additional for database, books, and Dynatext. We used a 200MB filesystem `/usr/OV`.

- Consider the diskspace requirements of the install process before starting. Tivoli first copies the required files into its own staging area, in `/usr/local/Tivoli`, and then moves them to their final locations. You will be installing one component at a time (base, then features, for example), so the staging area need only be large enough for the largest component. We found this to be 82M for the features component.

  `/usr/local/Tivoli` needs 82MB of free space.

- This installation will take longer than the installp installation of NetView V4. The movement of image files from the install media to the staging area account for most of the increased time. Also note that since you must install each component separately, operator delay can add to the elapsed time. If at all possible, we recommend that the install media be local, rather than remote, to avoid NFS performance and timeout problems, which can cause the installation to fail. Note that the installation time also varies widely with processor speed.

| Table 1. Observed Installation Times with Local Install Media |
|-----------------|-----------------|-----------------|-----------------|
| **Product**     | **RS/6000 250** | **RS/6000 760** |
| Base            | 40 min          | 20 min          |
| Features        | 30 min          | 20 min          |
| Configuration   | 5 min           | 2 min           |

- The TME NetView Server Configuration Facility is the component that puts the NetView icon on the TME desktop. It is a managed resource, and as such can be copied to various admin desktops. If you use the right mouse button on that icon, it gives you the same menus as typing `smit nv6000`. In addition, those menus cover all NetView for AIX targets within the Tivoli Management Region, and at the lowest levels in the cascading menus, you have the chance to specify which NetView you are administering.

- NetView is also fully functional without the TME NetView Server Configuration Facility installed. Access the menus in the usual way from the SMIT Communications menus, or by typing `smit nv6000` on the command line.

- NetView installation is registered to the AIX ODM database for use by dependent products. The result of `lspp -ha nv6000.base.obj` will show it is at the level 5.0.0.0, but no information about its status is available. That is, it will show NONE, rather than COMMIT or APPLY. You can also check its status from the Tivoli point of view using the `wlsinst -ph` command.

- Start NetView daemons from command line using `/usr/OV/bin/ovstart`, or start them using the configuration icon menus (right mouse button).

- Make sure all of the daemons are running - with OVstatus, or with the configuration icon (right mouse button)

- Start EUI with your Mapname using `/usr/OV/bin/nv6000 -m Mapname`, or start it from the Configuration icon (right mouse button).
Customize the daemons just as for NetView V4, but try it using the Configuration icon (right mouse button). You can leave a tear-off menu laying on the desktop for repeated access. Look for the dashed line across the top of a menu and pick it. Don’t forget to enable the Agent Policy Manager (C5 or APM feature) by configuring its daemon, if you plan to use Systems Monitor/6000.

2.3 Considerations when Installing Additional Applications with NetView

- Be aware that you may have problems installing such older NetView applications as Systems Monitor Configuration Application for NetView for AIX. These NetView applications may use an ODM query to make sure that the right version of NetView was installed successfully. They may not recognize nv6000.base.obj.5.0.0.0. In that case, you may need to modify the .toc for the product to accept the new version of NetView.

- If the installation script of the additional product ends successfully but fails to register the new application, so that it does not appear on the menus, for instance, you may be able to complete the installation manually. The following are general steps for completing such installations:
  - Copy the registration file into /usr/OV/registration/C
  - Copy MIBS to /usr/OV/SNMP_mibs and load them
  - Modify the usr/OV/conf/C/trapd.conf file.

2.3.1 Disable Start of NetView WebServer Processes

If you don’t want to start up the WebServer, you should change the /usr/OV/bin/nv6000 file by commenting out the line:

```
/usr/OV/web/httpd/NetViewServer ... &
```

Each time you start up the NetView user interface, another six processes are started, and as of this writing, they don’t stop when the user interface is stopped. They will have the same parent, and will go down when the parent goes down.

2.4 Enhancements to Discovery Using the netmon Seedfile

The use of a seedfile to control the discovery process is often beneficial, especially in large environments.

- Discovery is faster because the desired backbone devices are pinged. Without the pinging, IP devices that do not have any IP traffic running over them might not be discovered for a long time. To be pinged, a node must be included by IP address or or host name. A range or wildcard does not force discovery.

- Operator intervention is reduced, because the peripheral networks do not have to be manually managed for discovery to continue.

- The use of wildcards and ranges allows a seedfile to limit the discovery of nodes. For instance, a range might include hubs, routers, printers, and servers, but exclude user workstations. This can dramatically reduce the number of objects discovered, improving performance and reducing map clutter.

Prior to NetView V5, ranges or wildcards in the seedfile caused the seedfile to be treated as a restrictive seedfile. Seedfiles without ranges or wildcards were
non-restrictive. For the non-restrictive seedfile, which was just a list of explicit addresses, those addresses were sought out, and anything else found along the way was discovered as well. For the restrictive seedfile, any addresses encountered during discover were ignored if they did not match the ranges or explicit addresses in the seedfile. This meant that you were required to enter in the seedfile all possible ranges that were to be admitted. The danger of this was that a new device might appear on the network and be a source of problems, but it might not appear on the map if it fell outside the allowed range. Another problem was administration. New devices often required a change to the seedfile.

With NetView V5, this processing has changed. We can now use the NOT operand (!) in the seedfile to explicitly exclude addresses and ranges from discover. Anything not excluded is allowed to be discovered. You will still want to explicitly enter the addresses of your backbone devices to speed rediscovery, but it is not required. You can ping new devices and they will appear, but you still have the benefit of a restrictive seedfile that keeps out those devices you do not plan to manage.

Here is a sample of a netmon seedfile for NetView V5. Think about your addressing conventions, and you can probably come up with a short seedfile that will need very little administration.

```
9.24.96.1  # an explicit address to force discovery
9.24.96.2  # .. and another one
9.24.96.3  # .. and another one
!9.24.96.100-254  # exclude workstations on the 9.24.96 subnet
!9.*.*.50-254  # # other subnets have more workstation addresses
```

### 2.5 Enhancements to the Collection Editor

In NetView Version 5, more functions make use of the Collection Facility, and the Collection Facility itself has some very nice new features.

To define a new collection, select the **Collection Editor** under the Tools menu. It will first show you the list of collections already defined. Click on **Add** to add new ones.

With NetView for AIX V5 the Collection Editor has become much more flexible. It has an expanded set of operators for the comparison of attribute values. See Figure 3 on page 19. String-type attributes, such as Selection Name, SNMP sysLocation, or SNMP sysContact, can be checked for being LIKE or NOT LIKE a string. The LIKE operand is a tilde, and the NOT LIKE operand is an exclamation mark and a tilde (!~).
For instance, we could find devices whose SNMP `sysLocation` fields contain either the building designator, B678, or the street address of that building, 1001. The LIKE operand (\~) will find the strings within the longer location designator. Other new functions include wildcards for IP addresses, and regular expressions for strings.

Please see the regex man page for details. A copy of the man page as of the date of this document is in B.2, “MAN regex” on page 141 as a convenience to readers of this document.

We wanted to build some collections to be used later with a RuleSet that will forward certain events for certain devices to the T/EC server. The NC collection in Figure 4 on page 20 was defined based on the attribute SNMP `sysObjectID`, and specified the OID for some network computers in our network.
Figure 4. Adding Collection 'NC' Based on sysObjectID Attribute

The Router collection in Figure 5 on page 21 was defined based on the attribute isIPRouter. Note that this attribute is set to True for anything with multiple IP interfaces, so you might want a more complex definition if you really wanted it to resolve to only routers. Select the Test button to see what will be included in the collections, and click the OK button when you are satisfied.
Figure 5. Adding Collection 'Router' Based on isIPRouter Attribute

Figure 6 on page 22 shows the Collection Editor including our new collections, and some that were created by default by the Agent Policy Manager.
Figure 6. Collection Editor Window after Creating Our Collections

Now when we open the Collections submap on the Root submap, we find blue icons for the two new collections. When we open them, they are populated with copies of the objects that meet the criteria of the new collections. Figure 7 on page 23 shows the Router collection submap.
2.5.1 Adding a Collection from the Command Line

It is also possible to generate, delete, query or change collections from the command line or from shell scripts. The /usr/OV/bin/nvUtil command provides a line mode front end to the APIs, so you can work with Collections programmatically, but without writing C programs.

Here is an example that adds the same NC collection we just added:

```
nvUtil -a NC "All NetCentre Devices" "SNMP sysObjectID" = '1.3.6.1.4.1.2.3.15''
```

To list the members of the collection, use the -l option.

```
nvUtil -l <collection name>
```

Please see the nvUtil man page for details. A copy of the man page as of the date of this document is in B.1, "nvUtil" on page 137 as a convenience to readers of this document.

2.6 Enhancements to SNMP Configuration

SNMP Configuration is under the Options menu, and it now recognizes the Collection Facility. This could reduce the administrative burden of configuring community names and controlling polling behavior. In addition to the Node List section, the IP wildcard section, and the Default section, there is a new Collection section on the SNMP Configuration dialog. See Figure 8 on page 24.
For any previously created collection, you can specify the community names, retry and timeout, polling intervals, etc. If you intend to use it to specify a non-default read community, keep in mind that the collection must have been defined based on something other than SNMP attributes in order for it to exist in the first place.

There are also Reorder buttons on the Collection and IP Wildcard sections to let you control the order of evaluation.

While the IP Wildcard section has always been useful for adjusting polling intervals and timeouts for remote subnets, the Collection section would be very useful for making the same adjustments for classes of devices with similar requirements, such as slow servers, regardless of their position in the network.

After the configuration, you will see that the file /usr/OV/conf/ovsnmp.conf has entries for the nodes, wildcards, and defaults, but no entries for Collections. If you look in the directory /usr/OV/conf/ovsnmp.conf_db, you will see a new set of files, coldb.dir and coldb.pag, where this information is recorded.

Make sure that the collmap application is up and running while you are using the SNMP Configuration dialog. If it has failed for any reason, the Collection entries will appear to have been processed when in fact they have not. If that happens, delete them from the SNMP Configuration dialog, click on Apply, and re-enter them.

Figure 8. SNMP Configuration with Collection Feature
2.7 Enhancements to the RuleSet Editor

You will probably have uses for a number of different RuleSets, but one special use is to forward events to the Tivoli/Enterprise Console using the nvserverd adapter. The nvserverd adapter, which is built into the nvserverd code, was introduced by a PTF in NetView for AIX V4. One RuleSet at a time can be used to forward events to the T/EC server. Forwarding events to the T/EC server is discussed in more detail in the following sections. In this section, the term `RuleSet` refers to NetView RuleSets, not T/EC rulebases, RuleSets, or rules.

The RuleSet Editor has become more powerful in NetView for AIX V5 with the addition of the Query Database Collection template. This template allows you to test whether the event is from, or concerns, a member of a collection. This capability should simplify rules that apply to only certain devices.

In our example we created a RuleSet called TEC.rs that passes all events concerning members of our two new collections, NC and Routers.

![Diagram of NetView RuleSet with Two 'Query Database Collections' Nodes](image)

The Query Database Collection template is shown in Figure 10 on page 26 has two fields and two buttons. You specify the name of the collection, and whether the node should be in the collection, or absent from the collection. The Object ID Source field is a little confusing. Here you are to specify which element of the incoming trap is evaluated for membership in the collection. The choices are Origin, and then the numbers 1 to 7. Origin corresponds to $A in the NetView event, which would be the management station, for NetView events, or the node, for unsolicited traps. The numbers 1 to 7 correspond to variable bindings. For
NetView events, 2 would be $2$, the node that the event is about. If you generate test events using the command

event -E 105 -h router1 -a "this is the test data"

then the router1 would show up in element 2. If you use the snmptrap command for testing, then you can also control the Origin. You might want to include two Query Database Collection templates. One would compare Origin, to catch traps from the node, and one would compare element 2, to catch NetView events about the node. In your environment, you might well receive traps from other devices that mention your node somewhere else in the variable bindings. As long as it is within the first seven elements, the Query Database Collection template will catch it.

![Figure 10. Configuring the Query Database Collection Template](image)

Be sure to set the default action to Block in the Event Stream node (pizza) of the RuleSet.

Test your RuleSet by creating a dynamic events display, specifying the RuleSet, generating the events of interest, and monitoring the events display. To troubleshoot, use nvcdebug -d all to turn on tracing in nvcorrd, and nvcdebug -r to turn it off. In between, generate your test event. Then look closely at the file /usr/OV/log/nvcorrd.alog (or blog, whichever is in effect), and you will see your event being parsed and processed.
2.8 NetView Events and the Tivoli Enterprise Console

For detailed information on configuring the T/EC, and the various adapters available, please see TME 10 Cookbook for AIX Systems Management and Networking Applications, SG24-4867. While other adapters will still work, the preferred method is now the RuleSet adapter, also known as the nvserverd adapter. It is included in the code for nvserverd, and does not require the installation of any other products. All NetView events, and all unsolicited traps that flow from the network to the NetView management station, and all events generated by applications running on the management station can be initially filtered and processed by NetView, before being passed on to the T/EC server.

The general requirements for forwarding NetView events to a T/EC server are:

- Customize NetView events to be forwarded to the T/EC, if desired.
- Create the NetView RuleSet to be used to filter events.
  
  This was described in the preceding section, and is no different from creating any other NetView RuleSet.
- Configure NetView to forward events to the T/EC server, specifying the host name of the T/EC server and the NetView RuleSet.

  The menu selection for this can be found on the Configure menu for NetView. It creates or updates the /usr/OV/conf/tecint.conf file.
- Configure the T/EC server with Rulebases, Event Groups, and Event Sources.

  See TME 10 Cookbook for AIX Systems Management and Networking Applications, SG24-4867 for details on this process.

  General procedures are covered in 2.9, “Receiving NetView Events at the Tivoli Enterprise Console” on page 30.

  The Event Source for events from the nvserverd adapter is nvserverd.

  The nvserverd.baroc file, found in the directory /usr/OV/conf, is intended to be incorporated into a T/EC server rulebase. It contains the event classes and slot mappings for the nvserverd adapter for the events defined in NetView’s trapd.conf file.

  You can generate and include additional baroc files for traps not defined in the trapd.conf file, and you can map newly defined events to existing entries in the nvserverd.baroc file as well.

- Configure the T/EC event consoles for the Tivoli administrators.

  See TME 10 Cookbook for AIX Systems Management and Networking Applications, SG24-4867 for details on this process.

2.8.1 NetView Events and the RuleSet Adapter

The following example shows how you can add your own events to the NetView event configuration, and how you can forward these events to a TME10 Enterprise Console using the RuleSet adapter.

We began by adding a new enterprise in NetView’s Event Configuration dialog, ExampleEID, and a new event, specific event number 105, called Appl_Down.
The Modify Event dialog in Figure 12 on page 29 now includes two fields related to T/EC integration.

The T/EC Event Class field allows you to name the Event Class. Our Appl_Down event will be mapped to the NV6K_Application_Down_Event event class, which is an event class already defined in the nvserverd.baroc file. At present, there is no selection list available to fill this field, so take a look at the nvserverd.baroc file and watch your spelling. You can choose any class in any baroc file that has been incorporated into a T/EC rulebase.

In the nvserverd.baroc file, you will see that there are a lot of classes that start with NV6K, which are generally non-IP events, and a lot of classes that start with OV, which are generally IP status events. There is also an Nvserverd_Event class, which covers events related to the status of the nvserverd daemon.

The T/EC Slot Map field allows you to override the values of some of the slot mappings defined in the baroc file. The online help for this field tells you which slots are reserved and what variables are available for assigning values to the slots. All of the slots are originally defined in the nvserverd.baroc file. You can assign a value to the msg slot using literals in double quotes, or using a printf statement with variables from the trap. For easier parsing at the T/EC console, you can also assign values to variable bindings. For instance, you can set slot NV_VAR1 to the value in $2. Up to 15 variable bindings can be passed this way.
NetView makes special use of the T/EC slot mappings for many of its own events. For instance, if you look at the trapd.conf entries for the interface up, node up, and segment up events, you will see that they map to the same OV event classes as the corresponding down events. The difference between the Up and Down events is the T/EC slot mappings. Down events carry an OVstatus of 1 (critical) and Up events carry an OVstatus of 0 (normal). Up events also carry a status of CLOSED, which overrides the default (unspecified on Down events) of OPEN. This arrangement aids event correlation at the T/EC.

Next we tested our custom event by:

- Creating a dynamic events display and selecting our TEC.rs for it
- Generating our new event from the command line, specifying a host which is a member of the NC Collection
- Verifying that the events displayed as expected
2.9 Receiving NetView Events at the Tivoli Enterprise Console

Now you are ready to prepare the T/EC server to accept NetView events in general, and our custom event in particular.

On the system on which the Tivoli Enterprise Console has been installed, which in our case could be either the T/EC server itself, rs600024, or the TMR server, rs600011, we need to configure the following:

- Rulebases
- Event Groups
- Event Sources

All three are launched from the Event Server icon’s right-mouse menu.

2.9.1 Configuring Rulebases for the Event Server

From the Event Server right-mouse menu, launch the Rulebase selection. This brings up a collection of all existing Rulebases. Here you may create a new Rulebase and copy the Default rulebase into it. We created one called NetView.
Then choose **Import** to incorporate the `nvserverd.baroc` file, or to review the baroc files already imported. This dialog is both for importing RuleSets (in rls files), and for importing class definitions (in baroc files). The order of the baroc files is important, because entries on one may depend on entries in another. The `root.baroc` and `tec.baroc` files must come before the `nvserverd.baroc` file. When importing the class definitions, be sure to click the **Import Class Definitions** button. Select the **File** button to help you search for the file. Then click **Import** and **Close**. This figure shows the Import dialog after we have imported the class definitions in the `nvserverd.baroc` file into our NetView rulebase.
To create a RuleSet in a rulebase, you can either use the Import function to import a rls file, or you can use the Edit function to bring up the T/EC RuleBuilder. Figure 16 on page 33 shows the RuleBuilder. We selected **New Ruleset** to create a RuleSet called new_set to the RuleBase called NetView.
When we select Edit Ruleset to further edit the RuleSet new_set, we see the dialog in Figure 17 on page 34. Here we choose New Rule to add a rule to the new_set RuleSet.
We want to add a rule that will allow some event classes from the `nvserverd.baroc` file to pass, including the class of our custom event. Select an existing rule and the `Edit Rule` menu item, or just select the `New Rule` menu item. The New Rule menu item makes you choose between simple and compound rules. We chose to create a simple rule.

The Simple Rule dialog shown in Figure 18 on page 35 shows a summary of the rule. You can modify the event classes, conditions, or actions by clicking the appropriate button. We chose to set no conditions or actions, and included in the event classes a few NetView event classes.
When you click the Event Class button, you will see the Select Class dialog, pictured in Figure 19 on page 36. We are specifying the event classes to which this rule will apply (although in our case the rule actually does nothing but allow the event to pass, since we specified no conditions or actions). On the left of the dialog are the classes selected so far, and on the left are the unselected classes defined in the baroc files associated with this rulebase. Use the arrow buttons to move classes back and forth. In our example we are adding the NV6K_Application_Down_Event class to the selected classes, so the T/EC server will accept our custom event. Along with that class, we included some standard IP-related event classes.
The rulebase now must be compiled and loaded, and the event server must be stopped and restarted. Be sure to click all of the Save buttons along the way.

### 2.9.2 Configuring Event Groups and Event Sources for the Event Server

After the rulebase configuration is done, you will have to configure Event Groups and Source Groups. This is all part of configuring the Event Server. Sources follow along the lines of installed adapters. In our case, we added a NetView Source Group, and specified the source name to be nvserverd, an official designation that works with the nvserverd adapter. We also defined a NetView Event Group, with no filters except one which restricted the source to be nvserverd. See *TME 10 Cookbook for AIX Systems Management and Networking Applications*, SG24-4867 for details on these activities.

### 2.9.3 Configuring Event Consoles and Monitoring Events

The last configuration step is the definition of the T/EC Event Consoles on the admin desktops of the Tivoli administrators. See *TME 10 Cookbook for AIX Systems Management and Networking Applications*, SG24-4867 for details, but generally you will be creating a console on the admin desktop, adding event sources and groups, and setting permissions. In our example, opening the console brings up a monitor for the NetView Event group and the NetView Event Source. These contain the same events in our case, because we applied no filters to the NetView Event Group. The incoming events from NetView appear on the console in Figure 20 on page 37.
2.9.4 Some Useful Commands

- Stop and start the event server from the command line, using the following commands:
  ```
  wtstopesvr
  wtstartesvr
  ```

- Check the T/EC reception log to see if events were received.

- Type:
  ```
  wtdumprl -o DESC | more
  ```
  This will dump incoming events ordered most recently first, and will show their status as queued, processed, failed, etc. If it failed, the reason is given and should lead you towards solving the problem.

- If there is no response from this command, clearing the database and logs usually helps. Use the following commands:
  ```
  wtdbbackup
  wtdbclear -el -t 0
  ```
2.10 Threshold Monitoring

With NetView V5 integrated into the TME Framework, questions arise as to the relative benefits and positioning of the various monitoring applications available. We installed MLM for monitoring SNMP-manageable devices, configurable with either the Systems Monitor Configuration tool, or the NetView Agent Policy Manager, and monitored from the NetView EUI. Descriptions and discussions follow.

2.10.1 Configuring Threshold Monitors using the Agent Policy Manager

After the MLM component is installed and configured, select APM Configuration from the Tools menu. Select the type of monitor you want to establish.

Choose the Add/Copy button to build a new threshold monitor.
The example shows the configuration of a threshold monitor. With NetView Version 5 you can assign the monitor to a specific collection. Just click on **Assign** and choose one of the previously built collections.
After creating a monitor, you must distribute it to the systems that are to be monitored. In fact the distribution is an SNMP set to the MidLevel Managers that are managing the selected targets. If the Manager is not reachable the distribution will fail, but it will be retried until it succeeds.
As shown in the picture, the pagingspace distribution is marked as PartiallyDistributed. It will be retried until it succeeds.
The new monitor is now represented by an executable icon on the node submaps of the monitored nodes. It adds to the aggregate status of the node, along with the interface cards, so you can monitor its status from the NetView EUI.
2.10.2 Configuring Threshold Monitors Using the Systems Monitor

Configuration Applications (SMCFG)

The installation of SMCFG on the NetView for AIX Version 5 machine is a little bit tricky.

Systems Monitor Version 2 was designed before NetView version 5, and the second part of the SMCFG installation will not be executed. This can be completed by following these steps.

- Install SMCFG from SMIT menu using installp.
- Modify the installation script /usr/lpp/smcfg/backup/smcfg.eui.obj.config.
- Insert the line version=V3V4 after the lsllpp query is made.
- Save the file and go into SMIT, Systems Monitor V2 Maintenance.
- Select Reinitialize SMCFG Installation after NetView Installation to run the script again.

If the script runs successfully, you should be able to start the Systems Monitor Configuration application from the Tools menu of NetView. The MIB Browser should be able to show you all SIA and MLM object IDs.
2.10.3 Differences between APM Configuration and SMCFG Configuration

First we should build one configuration example by using the SMCFG application. Make sure that you have at least one node with SIA and MLM running in your environment.

1. Click on NetView Tools, then Systems Monitor Configuration V2.
2. Write the name of your MidLevel Manager node into the target field.
3. Select Threshold/Data Collection Table then click on Modify.
4. Fill out the fields as shown below.
5. Click the Apply button.

Advantages of using APM:
- Ability to distribute the configuration immediately to a large number of nodes or to a collection
- Monitors are affecting the ipmap, are directly connected to the topology view of the network

Disadvantages of using APM:
- You don’t get a status of the actual configuration. If the configuration is not active anymore you would not see it.

Advantages of using SMCFG
• You will get the current actual status of the configured machine.
• You will obviously have some more options to configure.
• You can save the configuration to the /var/adm/smv2/mlm/config directory to be sure that after reinitialization (started with -i) the configuration won’t be lost.

The disadvantage is that you have to use other tools to distribute to large numbers of MLM nodes.

### 2.10.4 Which Application Should be Used for MidLevel Manager Configuration?

Use only one tool (either MLMCFG or APM). If you change a monitor using SMCFG, the APM Configuration would not notice it.

Use MLMCFG if you have a stable secure environment and you want long-term monitoring of your environment.

Use APM if you have a dynamic fast-changing environment and you expect to change the monitors often.

---

### 2.11 wtdriver6

The wtdriver6 application is explained in several redbooks. We would like to show that it works properly with NetView V5. To obtain the wtdriver6 application, request it by using the Redbooks Home Page at the Web site: http://www.redbooks.com

or from within the IBM network, Anonymous FTP server at:

rserver.itso.ral.ibm.com
Directory: /pub/SG244898

The installation is done using a makefile. You change into the wt source directory and type make install. Restart NetView and try to start wtdrivermenu from NetView menu.

To show one example of creating an additional submap with two objects in it, run the following commands:

```bash
wtdriver6 -m ntvv focus Root
wtdriver6 -m ntvv add WTDRV6Example Software:Directory label
WTDRV6Example submap WTDRV6Example
wtdriver6 -m ntvv focus WTDRV6Example
wtdriver6 -m ntvv add NetViewStation Computer:Mini label
NetViewStation submap NetViewStation
wtdriver6 -m ntvv focus NetViewStation
wtdriver6 -m ntvv add Tivoli Device:Tape label Tivoli
wtdriver6 -m ntvv set Tivoli Up
wtdriver6 -m ntvv add NetView Device:Tape label NetView
wtdriver6 -m ntvv set NetView Up
```

Look into your Root map for a submap named WTDRV6Example. In the submap, there is one machine, NetViewserver. In the machine’s submap, there are two objects: Tivoli and NetView. Both of them are Up (green).
Chapter 3. TME 10 NetView Web Interface

The Web interface into NetView for AIX provides a wider group of support people with access to network management information without the overhead of running an owv process for each person. It also allows remote access over communication lines that would not accommodate X emulation. Nearly all of the familiar functions are present, primarily read-only, but they are presented very differently.

This chapter explains how the functions are organized.

3.1 Web Interface Usage Scenarios

One noticeable difference is the absence of topology. Connections are not represented, and all nodes are arranged in rows in the submap displays. This may impact your decision on how to cut and paste the map on the management station. Without the Web interface, you might have preferred to keep more detail on the top map, reducing the need to drill down to investigate problems. With the Web interface, you may decide that additional location icons convey more information about the layout of the network to the Web user.

Another approach would be to make greater use of the Collection Facility. Collections are already drawn this way, without topology. If collections are defined in such a way that they include the devices on which they depend, you will be able to tell if an outage is caused by an upstream node.

This interface is designed to allow each user to monitor multiple networks managed by multiple NetViews, and to easily switch between different maps on a given NetView. There is a separate login required for each NetView.

Diagnostic tools previously available in NetView for AIX have been grouped in a new way that is remarkably effective and convenient to use.

3.2 Starting and Navigating the Web Interface

The Web interface will work with any Web browser that supports frames, Java, and JavaScript 1.1. We used Netscape 3.01 on AIX.

If you create a collection called NetViews on one management station, then you will be able to choose among them from the Web client connected to that management station. You may also connect directly to the desired NetView. The choice of management station and map is available on nearly every panel. The map must be opened since the process that supports the Web client is spawned by the owv process for the open map. In fact, the owv process spawns up to 6 processes. As of this writing, these HTML processes are not killed when the map is closed. This allows Web users to transparently reconnect when the map comes back up, but it can get messy. Periodically you should kill old HTML processes, by identifying and killing the parent process.

Point your Web browser at http://<netview>:8008, where <netview> is the name or IP address of the management station. You will need to provide a user ID and password.
With Netscape, we noticed that at the bottom of the screen there is a status display that reports bytes transferred. When the screen is complete, that status is Stalled and the Netscape icon at the top right is still moving, as if it were incomplete. This appears to be normal behavior, and the screen is ready for input.

On the first page there are links to a README and Licensing information, and an Enter link that takes you to the main menu. This main menu is “home”. See Figure 28.

Figure 28. NetView Main Menu (home)

Throughout the screens, you can navigate either by the usual backward and forward arrows provided by your Web browser, or you can move directly to the various functions by means of the links provided on the bottom of each screen. Those link icons look just like the ones on the home page. The Tivoli logo is a link to Tivoli’s corporate home page. In addition, many functions also contain direct links to other functions, and the same icons are repeated.
3.3 NetView Processes (Status Display)

If you like the SMIT running man, go to the status display to see a whole squadron of men running in formation as in Figure 29. If the target management station is running at 100% CPU, the running men will freeze, but you can still navigate to other screens, and you can reload this one to get the current status. If you select one of the daemons, a pop-up displays the output of the OVstatus command. Currently you cannot stop or start daemons from here.

![NetView Process Status](image)

**Figure 29. Checking NetView Daemon Status**

3.4 Collections

Here you will find all of the collections defined to this NetView and counts of their members. See Figure 30 on page 50.
Figure 30. Collections Main Menu

We selected our NetViews collection in Figure 31 on page 51. All panels showing icons with status, such as this one, have a status summary across the top showing how many icons have each possible status, and a selection list to let you filter the display by status.
Figure 31. Our NetViews Collection

From here, selecting either the node or the label of the node will bring up the NetView Information About: nodename panel. This panel is also available from the Submap displays and the Events displays and is discussed in more detail in 3.8, "Events Display" on page 61.

3.5 Diagnostic Applications

The Diagnostics panel requires you to provide the name or address of the node in question. Then you have access to the functions found under the Test menu on the server (Ping, DemandPoll, TraceRoute), plus the MIB APPLs, Display Object Info, and Events, all for this node.
The little icons across the middle of the panel represent the various test available. The results of some tests follow.
Figure 33. Ping Results
Figure 34. DemandPoll Results
Figure 35. Display Object Information
3.6 MIB Applications

This panel presently offers only the Form and Table MIB applications from the Monitor menu on the server. As with the diagnostics, you must provide the name or IP address of the target node. You may also provide a community string on this panel.
In Figure 38 on page 58 you can see the output of the Interfaces MIB application. It also shows the selection list of MIB applications available. Notice that the names used here are the names used in the MIB Application Builder, not the names that show on the Monitor menu on the server.
Figure 38. Selecting a MIB Application

Figure 39 on page 59 shows the output of the PhysAddr application, which is also known as Monitor..MIB Values..Interface Info on the NetView server.
3.7 MIB Browser

This looks just like the MIB Browser on the management station. As of this writing, the community string could not be updated. See Figure 40 on page 60.

Figure 39. Results of the PhysInfo MIB Application Query
The results of a query of the System MIB info can be seen in Figure 41 on page 61. The Set functions were not available as of this writing.
3.8 Events Display

From the Events main panel, you can choose a RuleSet to apply to the events retrieved. All RuleSets defined on the server are presented in the selection list. Click on Start to begin retrieving events from the designated server. The most recent 100 events are retrieved.
Figure 42. Choosing a RuleSet on the Events Main Display

This display is dynamically updated with new events as they occur.

The NetView Events Display in Figure 43 on page 63 shows all events passed by the selected RuleSet. Notice the tabs for filtering by severity. The Clear or Clear All buttons at the bottom of the display are not related to the Cleared tab. The Cleared tab shows events that came in with a severity of Cleared. The Clear and Clear All buttons on the bottom of the display will remove events from this display when you are through with them.
Figure 43. All Events

See Figure 44 on page 64 for an example of events filtered by severity. This shows all critical events in the current batch. The severity is set on the server in the Trap Customization dialog. Initially, nearly all NetView events are configured to be ’Indeterminate’ and for this example we modified some of the Down events to have a severity of Critical, and some of the Up events to have a severity of Cleared.
If you select a single event about a node, the MIB Browser and the Show Node buttons become available. Clicking on Show Node brings up the NetView Information About: panel for that node. This panel is similar to the Diagnostics panel, but the node in question is already filled in.

For example, in Figure 44 we selected a Node Down event for winnt80. If you click on Show Node, you see the panel in Figure 45 on page 65. The diagnostic functions are pictured across the top, and we can see by the motion of the Ping icon that the Ping has already been started for us. We can tell from the little status light that the node is now Up. We can use the Demand Poll function to verify its status and update the map, instead of waiting for the next polling cycle to correct it.
Figure 45. Checking Node Status After a Node Down Event

The SNMP system information is also included in the panel (from the NetView database) if the node supported SNMP at the last successful configuration poll. The test functions listed across the top of the panel provide the very same set of test that we saw in the Diagnostic Applications main menu.

To get Figure 46 on page 66 we selected a Node Down event for an 8274. The same Info About panel is reused for this node, and the status light shows red. Since the SNMP information is displayed, we immediately know its location and who to contact. To make sure it is down, we can try to ping it again. We can also look at recent events for this device.
3.9 Submaps Display

The Submaps main menu is the Root submap, just as it is displayed on the server. See Figure 47 on page 67.

Note that reverse navigation by means of the Back arrow on the Web browser requires two steps back for each step forward in the Submaps display as of this writing. This appears to be normal.
Figure 47. Root Submap

In Submaps, icons and their labels have links to different functions. Selecting the icon will explode it, showing a lower level submap, similar to the server. Selecting the label for nodes will bring up the Info About panel for that node. This panel is discussed in 3.8, “Events Display” on page 61. Selecting the label of non-nodes, such as Location objects and Root objects, gives you a display of Object Information from the NetView database. See Figure 48 on page 68 for an example of this.
Selecting the IP Internet icon takes you to the IP Internet submap, but unlike the map on the server, there are no connections displayed. Making good use of this display would require a good knowledge of the network layout, a very simple network, or creative use of location objects.

All submaps have a status summary across the top, totaling the number of objects having each status, and a filter button to let you choose to see only objects of a certain status. See Figure 49 on page 69 for an example of this. The counts apply only to the objects on the current panel and do not include any lower-level resources.
Figure 49. Choosing Status Filter on IP Internet Submap

Drill down on a network symbol to see a Network submap. In Figure 50 on page 70 we see the usual hubs and routers for this subnet.
Figure 50. A Network Submap

Drill down on a segment symbol to see a Segment submap. In Figure 51 on page 71 we see all of the end devices on this segment.

This submap has 171 objects, and is probably too crowded to be useful.
Figure 51. A Segment Submap Showing All Nodes

By changing the filter from All to Abnormal, we can reduce the content of the display to just those nodes that require attention. See Figure 52 on page 72. If you select the label on one of the nodes, you will get the Info About panel discussed in 3.8, “Events Display” on page 61.
If you select the icon for the node, rather than its label, you get the same node submap display that you would see on the server, with interface cards as in Figure 53 on page 73.
Location submaps behave the same as the IP Internet submap. In our lab environment, we seemed to have trouble with Netscape failing when we tried to open the Location submap, but it finally worked sporadically, so the problem was probably environmental.
Figure 54. A Location Submap
Chapter 4. Using NetView/NT

4.1 Installing NetView/NT

This chapter guides you through the installation of the TME 10 NetView for Windows NT. It will give you hints about prerequisites, potential pitfalls, and possible side effects.

Refer to the following documents for additional information:

*TME 10 NetView for Windows NT User’s Guide*, GC31-8415
*TME 10 NetView for Windows NT Programmer’s Reference Guide*, SC31-8416
*TME 10 NetView for Windows NT Programmer’s Reference*, SC31-8417

4.1.1 Prerequisites

To install NetView/NT successfully, you need to check a few items before starting the installation. Be sure the workstation you are going to install NetView NT on provides at least the following:

- Windows NT Server Version 4.0 or later.
- An NTFS partition with at least 95 MB of free disk space for Intel platforms.
- 120 MB paging space.
- For Intel platforms, at least a 90 MHz Pentium processor; a 166 MHz or faster processor is recommended.
- Minimum of 48 MB of RAM. We recommend at least 64MB. Additional memory will improve performance and is necessary for larger networks.
- Network interface card (NIC) supported by Windows NT.
- A graphics adapter capable of supporting resolution of at least 800x600. An adapter supporting 1024x768 or higher is highly recommended.
- The TCP/IP protocol installed and configured.
- SNMP service installed and configured.

Note:

To install the NetView/NT program, you must be a member of the Administrators Group. You should then run the NetView/NT program using the same account from which you installed it. If you run from a different account, you may experience file permission problems.

4.1.2 Checking/setting Paging Space

NetView/NT requires a minimum of 120 MB of paging space. To verify and adjust this value, use the Control Panel and double-click on the System icon. From the resulting system properties dialog, select Performance. Click on Change. This will lead you to another dialog similar to Figure 55 on page 76. Check the settings and adjust your paging space to a minimum of 120 MB.
Figure 55. Setting Page Space for NetView/NT
4.1.3 Checking/Installing SNMP Services

Note

If you are not able to add/install the SNMP Services or it seems the services are already installed but NetView NT does not seem to work correctly, your system may have some outdated information in its registry. You need to check the registry for SNMP-related information and delete it.

Although it is very likely that your Windows NT has TCP/IP already installed, it may be necessary to install the NT SNMP service.

From the Control Panel choose Network. In the dialog shown, choose the Services tab and then click on Add. Select SNMP Service from the resulting list and click OK. This will take you back to the network configuration dialog. Click OK to complete SNMP configuration.
4.1.4 Configuring SNMP Services

As soon as you have successfully installed the SNMP service, you should check the configuration of the SNMP agent. From the Control Panel, double-click on the Network icon. Select the Services tab, highlight SNMP Service, and click on Properties to configure the Windows NT SNMP related parameters.

**SNMP Agent Configuration:** Select the Agent tab to display the SNMP Agent configuration dialog (Figure 57 on page 78).

![Microsoft SNMP Properties](image)

The SNMP Agent dialog can be used to set the sysContact and the sysLocation MIB variables. Furthermore, you can specify which service is provided by your Windows NT workstation. Activate the checkbox for each service you need. The meanings are as follows:

Figure 57. SNMP Agent Configuration
Physical  You need to activate this if your workstation manages physical devices such as repeaters.

Internet  Activate this service if your workstation has more than one interface and therefore can act as an internet gateway.

Applications  Activate this box when the workstation is running TCP/IP based applications. NetView NT is a TCP/IP based application, so this box should be checked.

Datalink/Subnet  Activate this box if the workstation manages TCP/IP subnets. Running NetView NT implies managing subnets, so set this box to active.

End-to-End  This service should always be checked. It is required since the workstation acts as an IP host.

**SNMP Trap Configuration:** Select the [Traps](#) tab to display the Traps dialog (Figure 58 on page 80).
For each community name, you can specify a separate trap destination. For now, we will assume our workstation is the only network manager in our network, so we are supposed to receive traps rather than forwarding them to some higher-level manager.

**SNMP Security Configuration:** Selecting the **Security** tab leads you to the SNMP Security Configuration as in Figure 59 on page 81.
This dialog allows you to specify the community names which you want to accept. If you check the **Send Authentication Trap** box, Windows NT will send an invalid community name trap to its trap destinations if you have specified any. In addition, you may specify acceptance of an SNMP packet from any host or you may limit the acceptance of SNMP packets to a list of hosts that you specify. For initial discovery it is a good idea to accept packets from any host.
4.1.5 Installing NetView NT Program Files

After verifying the SNMP configuration, we are ready to install the NetView NT program files.

Figure 60. Starting Setup Program

Insert the NetView/NT CD-ROM. Using the Windows NT Explorer, a directory tree similar to the one shown in Figure 60 should be displayed. You might first select the README.WRI file and have a look at last-minute information. Then, select SETUP.EXE, which will start the installation process. Remember, you need sufficient disk space and sufficient page space; otherwise, the installation will fail.

Once the install process has been started, you will be presented with a window, which reports the progress of the installation.

Do not interrupt the installation. After a while, a Setup Completed message will appear.

The message asks you to restart Windows. Restart, by clicking the Restart Now button. After Windows NT comes back up, the shortcuts to the NetView applications will appear on the Windows NT Start menu as in Figure 61 on page 83. This concludes the installation process and you are ready to use NetView/NT.
4.1.6 Starting NetView/NT Server

Most of the processing done by NetView NT is performed via background programs called daemons. The Graphical User Interface (GUI) does not need to be launched in order to discover and manage your network. The daemons do their work behind the scenes as long as they are active and healthy.

To start the daemons, select Programs->NetView-> Start Server from the Windows NT Start menu. The dialog in Figure 62 on page 84 is displayed and shows the daemons and their current operating state. If the daemons are marked RUNNING and the message field at the bottom of the dialog displays Done, then NetView/NT is ready to manage the IP network.
All of the daemons displayed in the dialog should be active in order for NetView NT to function correctly.

Some of the tasks the daemons are responsible for are as follows:

**netmon** The netmon daemon is responsible for the discovery of IP objects in the network. IP object is a network node with an IP address. Once an object is detected by netmon, it uses SNMP to query additional information such as system information, various IP related tables and the forwarding status. This information is put into the NetView NT object database.

Then, netmon polls the object at regular intervals to retrieve its configuration and current status.

The first time netmon is started, the daemon discovers the following objects:

- All nodes in the local network segment (the segment in which your NetView NT workstation resides).
- The local network segment itself.
- All routers and gateways which have an interface in the local network segment. From NetView NT’s viewpoint, a router or gateway is an IP object with more than one network interface/IP address.

**trapd** The trapd daemon receives SNMP traps from netmon and other NetView NT processes. If logging is activated, traps will be logged in `\usr\ov\log\trapd.log` or whatever file you set as trap destination. Note that trapd logging is not activated by default.
This daemon maintains the network topology database of NetView NT. This database holds information about all the IP objects that have been discovered. When a network object changes its status, this information is sent to ovtopmd by netmon and is used to update the database.

---

**Hint**

To activate tracing and/or logging for the trapd daemon you must toggle the tracing or logging facility by sending appropriate commands to trapd. You can do this by issuing the commands:

```
trapd -T  To toggle the trapd tracing facility.
trapd -L  To toggle the trapd logging facility.
```

For performance reasons, you should use tracing and logging only for problem determination purposes.

---

### 4.1.7 Bringing Up a Map

After starting your background processes, you are ready to bring up the graphical user interface (GUI) of NetView NT. You can launch the GUI by selecting Programs->NetView->NetView Console from the Windows NT Start menu. In this case, NetView NT will be brought up with a default map. To start the GUI with maps other than the default, you can create Windows NT shortcuts as described in the next section.

#### 4.1.7.1 Starting NetView NT Console via a Windows NT Shortcut

One of the properties of Windows NT shortcuts is the ability to invoke application programs with different parameters, thus affecting how they behave on startup. In our case, we need to tell the NetView console (GUI) application which map to use when it starts up.

To create a shortcut:

1. Using the *right* mouse button click once on the Windows NT desktop, and select New->Shortcut (Figure 63 on page 86). This will bring up a Create Shortcut Windows NT wizard (in case you are not familiar with Windows NT wizards, they are programs that Windows NT employs to guide the user through administrative and other functions).
2. In the Command line: field, enter

   <drive>:\usr\ov\bin\netview.exe -map <mapname>

   where <drive> is the physical drive where your NetView NT installation resides (Figure 64 on page 87).
3. Click the **Next** button.

4. Enter a name for your shortcut, and click the **Finish** button.

Now you are ready to launch the NetView NT GUI. Double-click the new shortcut icon and NetView NT will start with your assigned mapname (Figure 65 on page 88).
If NetView/NT displays the message shown in Figure 66 on page 89, you forgot to start the daemons. Don’t worry, the GUI startup will do that for you. But remember, that as long as the daemons are not running, discovery and event handling will not take place.
After a while you will see the NetView NT main window. Click the **HP Internet** icon from the root map and NetView NT should present you with an IP map similar to Figure 67 on page 90.
4.1.8 Configuring SNMP

NetView NT uses a set of default values to poll nodes for status and configuration information. In real world, you probably need to manage many different network segments interconnected using different types of links, including relatively slow public carrier lines. In such an environment, using the default polling values may result in the inefficient usage of the bandwidth. To overcome this problem and to fine-tune the NetView NT behavior, you will have to adjust polling options.
4.1.8.1 Setting Polling Options

NetView NT polls every managed node in the network for:

- Status
- Discovery
- Configuration purposes

You can set different options for each of the tasks above. From the NetView NT console, select **Options->Polling**, which will lead you to the dialog shown in Figure 68. As you will see, the default period for status polling is 20 minutes. This might be a little too long for LANs, especially when you need to manage critical devices. We suggest that you adjust the default value to suit your requirements. For example, five minutes for status polling is a reasonable value for LANs.

If you check the Poll to Discover New Nodes checkbox in the Polling Options dialog, NetView NT will poll all already discovered nodes to get information about new nodes. By default, NetView NT will automatically adjust polling intervals. That means, that during initial discovery, the intervals will be
relatively short. Eventually, as the number of new nodes being discovered decreases, this interval will be extended to approximately two hours.

The third value you can configure from this dialog is the poll for configuration interval. NetView NT maintains information about network-related configuration parameters of each discovered IP node in its database. If any of this information changes between two poll cycles, NetView NT will generate an event to inform you about the changes. The following information is retrieved during a configuration poll:

- Change in contact or location, retrieved from the system.sysContact and system.sysLocation variables
- Forwarding status, taken from the ip.ipForwarding variable
- Number of interfaces from interfaces.ifNumber
- Incorrect routing
- Address mismatch
- Change in the network mask
- Change of the node name
- Object Identifier change from system.sysObjectld
- SNMP support
- Undetermined link address

Generally, the above parameters don’t change very often. You can leave the default value untouched and the configuration of the nodes will checked once a day.
Selecting the Daemons tab of the Polling Options dialog allows you to set daemon-related polling intervals. By default, NetView NT checks all the running daemons and restarts them as necessary.
4.1.8.2 Setting SNMP Options
As mentioned above, the default parameters for status polling and discovery are suited for non-critical devices in a LAN environment. To manage critical resources, or to adjust polling parameters for slow links on a per-node basis, you can use Options->SNMP. This dialog (Figure 70) allows you to set options for the following:

1. Specific nodes
2. IP address wildcards
3. Default

It also allows you to specify a community different from the default one, thus allowing you to define different communities for different subnets and/or hosts.

![SNMP Options dialog](image)

**Figure 70. Setting SNMP Options for Specific Nodes**

4.1.9 NetView/NT Instrumentation
Windows NT Performance Monitor can be used to collect and analyze various NetView NT related performance data. The collected information may then be used for sizing and capacity planning.

After the NetView/NT daemons have been started, clicking the + button on the Performance Monitor tool bar and examining the Object list, shows that NetView is one of the available objects, providing counters as shown in Figure 71 on page 95.
Figure 71. Performance Counters Provided by NetView

Figure 72 on page 95 shows the Performance Monitor graphs corresponding to the NetView counters. The user is encouraged to collect the data on a regular basis and compare the values every month or so.

Figure 72. Graphical Display of NetView Performance Counters
4.1.10 Disk Space Considerations

A full installation, of NetView NT including help files and online books, requires approximately 100 MB of disk space.

In addition to this static space, you will need disk space for log files. With the standard settings, the log files will take a maximum of 3 MB disk space. If you increase the number of logged events or activate one or more of the trace options, you should make sure sufficient disk space is available.

Disk space is also required for the NetView NT databases. 2000 objects occupy approximately:

• 1.5 MB of disk space for the map database, for each map you define
• 3.0 MB of disk space for the ovwdb database
• Around 800 KB disk space for the topology database

We encourage the reader to monitor the sizes of the critical NetView NT files and to provide for sufficient storage.

4.2 Using the Base Product

This chapter provides examples of using the base NetView NT product. We will discuss the NetView NT console application, the MIB Browser, the NetView NT Events Browser application, and the appmon application. We will also talk about SmartSets, a powerful NetView NT feature that allows you to group objects with similar properties and create submaps containing these collections.

4.2.1 Supplied Applications

During the installation of the NetView NT product, a NetView submenu is added to the Windows NT Start menu. This submenu gives you access to all the NetView NT applications, utilities and documentation (Figure 73).
The following list gives a brief description of the provided applications and utilities. The rest of the chapter will discuss some of these in greater detail.

**TME 10 NetView Console**  
The main NetView NT application. Selecting this item will launch NetView NT with a default map.

**NetView/NT Event Browser**  
The NetView NT event browser is used to manage events and traps sent to NetView NT by managed objects. You may launch multiple instances of this application and apply a different filter to each instance.

**MIB Browser**  
The MIB Browser is an application that allows you to query, examine and set (if you have read/write permission) the MIB of any accessible node in the network.

**Start Server, Stop Server, Server Status**  
These icons represent shortcuts to the appmon application (see 4.2.4, "appmon Application" on page 108). They allow you to quickly retrieve the current status of the NetView NT daemons and stop or start the daemons.

**NetView Setup**  
If you select this item, you will get a dialog that allows you to configure the various NetView NT daemons as well as to clear log files and databases. You should use this application with caution.

**Process Viewer**  
Provides an overview of the active processes running on the workstation. You may select all or just the NetView NT processes to be displayed.

**Read Me**  
This is a Microsoft Write file containing last-minute information and hints.

**NetView Help**  
A shortcut to the Microsoft Windows-style help files.

**Online Books**  
Opens the Dynatext reader, which will give you access to the online documentation.

**FAQ**  
This is a Windows NT-style help file containing useful information for users who are new to NetView NT.

**Installation Manager**  
The installation manager allows you to re-install NetView NT in order to retrieve missing files, or to completely de-install the NetView NT product. You will need your NetView NT CD to use this application.

**Installation Log**  
Contains information about your NetView NT installation.

### 4.2.2 Using the MIB Browser Application

One of the most powerful and very often used applications in an SNMP management environment is the MIB Browser application. You may use it to query and set MIB variables or even browse groups of MIB variables.
You can launch the MIB Browser from within NetView NT by selecting a node on a map and clicking **Tools->MIB->Browser** or by selecting **Programs->NetView->MIB Browser** from the Windows NT Start menu. In the latter case, you will need to provide the node name or the IP address of the workstation whose MIB you want to query. Enter the name or address in the upper left corner of the dialog shown in Figure 74, along with a valid community. The default community is generally a community called public. The public community allows you to read MIB variables, but not modify them. You may browse the MIB and display values by either selecting a group of variables, or a single variable. Just make your selection and click the **Get Values** button.
To set (modify) a MIB variable, you need to make sure that the following conditions are met:

1. Variable is of type readWrite
   and
2. The community allows you to modify variables.

The example in Figure 75 shows how to modify a variable. The name of the variable to be modified is iso.org.dod.internet.mgmt.mib-2.system.sysContact. sysContact is a readWrite variable on most systems, which means you can modify it via a SNMP set request. The target machine, where sysContact was
modified is one of the ITSO workstations called rs600010.itso.ral.ibm.com. This workstation accepts SNMP set requests if they are sent with a community of ITSC.

Using the NetView NT MIB Browser, you need to fill out all the required fields:

1. Provide the correct community (ITSC in our case) in the Community Name field of the dialog.
2. Choose the variable to be modified. The easiest way to do this is to scroll down the MIB tree using the Down Tree button.
3. Once selected, you need to query the variable first by clicking the Get Values button. Make sure, the field left of this button is set to MIB Values. Otherwise you will get a textual description of the selected MIB variable.
4. After the variable has been queried, the result of the operation will appear in the message field below the Get Values button. Select the result line by clicking on it.
5. Now the result should appear in the New Value field at the bottom of the dialog. Next you may modify the content of the field and submit the changed value by clicking the Set button.

4.2.3 Examining NetView NT Objects

NetView NT maintains a database of all of the discovered objects. The information stored in the database includes object status, configuration information, and information used to build the network topology. Inspecting object information can be useful for the purposes of maintenance and problem determination. NetView NT provides two ways of examining the object database: a stand-alone text-based tool, and a graphical interface, available from the NetView NT console menu.

Using ovobjprint: Ovobjprint is a simple text-based tool for accessing the object database. To use this utility, you need to open a Windows NT Command Prompt window and invoke ovobjprint from the command line. Ovobjprint accepts various command line options. If no options are given, ovobjprint displays all the field values in the database grouped by object ID. If command line options are specified, ovobjprint behaves as described below:

-S Causes ovobjprint to display a summary of the information stored in the object database. This summary includes information on the number of objects in the database, the number of fields defined in the database and the number of field values in the database. This information is useful when sizing the database in relation to physical storage requirements, or when analyzing the system performance.
Figure 76. Database Summary

- **s [selection_name]** Causes ovobjprint to display field values based on the object name. If the optional parameter selection_name is supplied, all the field values for the object identified by the object name are displayed. If selection_name is not supplied, the object name of every object in the database will be displayed. The output also displays the object_id, which can later be used with the -o option.

- **o [object_id]** Causes ovobjprint to display all the field values for the object identified by object_id.

- **f [field_id]** Causes ovobjprint to display field information. The field information includes Field ID, Field Name, Field Type, and Field Flags. If the optional parameter field_id is supplied, only information concerning that field will be displayed. If field_id is not supplied, information on all fields in the database will be displayed. No field values, themselves, are displayed when using this option.
Figure 77. ovobjprint -s $hostname$ -e $field_id$

```
C:\>ovobjprint -s mgnt1:IBM

OBJECTID: 515

FIELD ID  FIELD NAME       FIELD VALUE
----------  ----------------  ----------------
  10        Selection Name   "$hostname$"
  14        OVM Maps Exists  2
  15        OVM Maps Managed 2
  17        IP Address       "$24.104.205"
  18        IP Subnet Mask   "$255.255.255.0"
  19        IP Status        Normal
  59        isCard           TRUE
  60        isInterface      TRUE
  68        isIP             TRUE
  92        SNMIP ifType     "IEEE 802.5 Token Ring(9)"
  93        SNMIP ifPhysAddr "08000A5530E7"
  94        SNMIP ifDescr    "IBM Token Ring Network"

Card for MCA bus.
```

```
   100   TopM Network ID  517
   101   TopM Segment ID  518
   102   TopM Node ID     516
   115   XRMAP Protocol List "IP"
   116   XRMAP SAPs Used List 0

C:\>
```

4.2.3.1 Examining Objects Using the NetView NT GUI

Ovobjprint is useful when examining the entire database or large groups of objects. The output of the command can be printed or redirected to a file for further analysis. To examine the status and capabilities of a single object, however, you may find it faster and easier to use the GUI.

To view an object from the GUI, simply select the object and choose **Object->Object Properties** from the NetView NT menu.
In Figure 78 we selected one of the routers on the network to examine its object properties.

4.2.3.2 NetView NT Event Browser

Once NetView NT begins to manage your network and discover objects, it also starts to produce events. NetView NT generates events as a result of its polling activity and as a result of traps it receives from network objects that have their SNMP trap destination set to the system NetView NT is residing on. You can display events and, more importantly, you can filter based on specified criteria.

As with most NetView NT applications, you can bring up the Event Browser application either from the Windows NT Start menu, by selecting Programs->NetView->Event Browser, or from within NetView NT Console by selecting Monitor->Events->Current Events.
Figure 79. NetView NT Event Browser Window

Once started, the Event Browser will display the incoming events as in Figure 79.

To get more information about a particular event, first highlight the event by clicking on it in the Event Browser window. Then, select **View->Event Details** from the Event Browser menu (Figure 80 on page 105).
4.2.3.3 Event Utility

One of the utilities shipped with NetView NT is `event.exe`, a Windows NT console program. You can use this utility to send events to NetView NT. The events are identified as originating from the NetView NT enterprise.

If `event.exe` is invoked without command line options, it simply sends a Node Up event to NetView NT. To add a comment to the event you can issue the command with a `-d` option, as in `event -d "some comment"`.

4.2.3.4 Trap Configuration

Take a closer look at Figure 80. In addition to other information, you will see the following lines:

- Enterprise
- Trap

The enterprise name and the trap number are very useful when you want to react to certain events in your network. NetView NT events are treated as SNMP traps. Each trap can be configured according to a specific format. This configuration can be used to get more information about the trap, and also to take certain action when the trap is processed.
NetView NT ships preconfigured with a large number of traps. If, however, a trap arrives that is not known to NetView NT, don’t panic: NetView NT provides you with the tools required to configure traps and events.

If you select on Options->Trap settings from the Event Browser menu, NetView NT displays the trap settings dialog (Figure 81). The dialog displays a list of enterprises along with all the traps that are defined for each enterprise. If you go through the enterprise list, you will see that there are a few traps that are common to most enterprises. Thus, the enterprise ID can be used to determine the origin of a trap if you are receiving multiple traps of the same type.

Now use the scroll bar and look for the enterprise NetView. Highlight it and then look for the NodeUp event in the trap list. The traps are sorted in alphabetic order; you don’t have to look for the trap number since you know you are looking for NodeUp.

Select the NodeUp trap and click on Properties. The resulting dialog allows you to customize the trap (Figure 82 on page 107).

You can even specify a command to be executed upon arrival of a trap. This lets you automate some of your network management tasks.
The Trap Settings dialog is also used to define formats for unknown traps. Click on the New button and the Event Browser will display a dialog that lets you configure new traps (Figure 83).
You can prevent certain events and traps from being displayed in the Event Browser window by using event filters. To define a filter select **Filter->Set** from the Event Browser menu (Figure 84 on page 108). The resulting dialog allows you to define a filter based on such criteria as event severity, event category, date, and others.

You can set a different filter for each Event Browser window that you have open. You could, for example, open a window where all the warning events are displayed, and a separate window for critical events.

![Figure 84. Setting Event Filters](image)

### 4.2.4 appmon Application

The appmon command allows a developer to encapsulate an output-only, Windows NT console-based application, so that it can be used with the NetView/NT GUI. Appmon can sort the output, print it, or save it to a file. It can also help to provide a standard NetView NT look and feel to custom applications.

As an example, if you would like to encapsulate the output of the ovstatus command, use the following command in the appropriate registration file:

```
appmon -commandTitle "Status of NetView Products" -commandHeading Status -cmd /usr/OV/bin/ovstatus
```

For a complete list of appmon command line options, see the *TME 10 NetView for Windows NT Programmer’s Reference.*
4.2.5 SmartSets

SmartSets is a feature of NetView NT that allows you to group objects with like attributes. You can then use these collections to keep track of objects with common characteristics without having to examine each one. As an example, let’s suppose that we want to create a collection of all the routers (objects with multiple network interfaces and IP addresses) on our network. From the NetView NT GUI menu select Edit->Find. This will result in a dialog similar to Figure 85. Next, select the Simple tab and choose Other Properties from the Find by list box. Then click on the Type radio button, and select Router from the corresponding list box. Make sure that the check box next to the list is marked. Click the OK button. This will cause the NetView NT to display all the routers it finds in a NetView NT console window (Figure 86 on page 110). Finally, click the Create SmartSet button to create the group. After asking you to supply a SmartSet name and description (Figure 87 on page 111), NetView NT will add the new collection to the SmartSets submap (Figure 88 on page 112).

Figure 85. The Find Dialog Box
Figure 86. A List of Found Objects
Figure 87. Creating a SmartSet
Let’s create another SmartSet. This time, we will group all the workstations on our network. The resulting SmartSet will look like Figure 89 on page 113.
Now let’s suppose we would like to group together all the workstations that are also routers. To do so, we first need to bring up the Find dialog as before. Again, we will select Other Properties from the Find by list and Router from the Type list. Instead of clicking OK as we did before, we will click the Add to Advanced button. This will take you to the Advanced tab, so click on Simple to get back. Now we will repeat the procedure for the workstation type. The result will look like Figure 90 on page 114. Now we can click OK and then Create SmartSet. The new SmartSet is shown in Figure 91 on page 115.
Figure 90. Advanced Search
4.3 Extending the Base Product

This chapter provides examples of extending TME 10 NetView for Windows NT through the use of the NetView NT OVW application programming interface (API) and other user developed utilities.

4.3.1 ITSO-Raleigh Sample Application wteuiap6

ITSO-Raleigh has been using the wteuiap6 sample application in a number of projects related to NetView NT. The original version of the application was developed on AIX. After the release of NetView NT, the application was ported to the Windows NT platform.

Some of the material in this chapter originates from Examples of Using NetView for AIX, GG24-4327. It is included here as a convenience to the reader. The examples make use of the wteuiap6 application and its companion driver wtdriver6.exe to demonstrate the End User Interface (EUI) or display functions of the API. Figure 92 on page 116 depicts a high-level architecture of the wtdriver6/wteuiap6 approach.

Figure 91. Workstation That Is a Router
The user issues the commands using the wtdriver6.exe program. Wtdriver6.exe interacts with wteuiap6.exe through the services provided by wtpbx6.exe. Wteuiap6.exe is registered with NetView NT so that it is invoked whenever the NetView NT console is launched. It translates user commands passed to it by wtpbx6.exe to NetView (OVW) API function calls, thus manipulating the maps and some of the databases.

Figure 92. wtdriver6/wteuiap6 Overview
4.3.1.1 wtdriver6 Functions
The following figure summarizes the usage of the wtdriver6.exe utility

Usage: wtdriver6 [flags] command [...]
Flags:
[-h wtpbx6-hostname] - Specify the machine that is running wtpbx6 (default is local)
[-b] - Send the request to all displays (broadcast)
[-d target-display] - Send the request to a specific display
[-f submap-name] - Define the focus (just for this command)
[-m map-name] - Send the request to a specific map

Commands:
stat
msg message
focus submap_name
popup submap_name
submap submap_name [auto [layout [background-image]]]
submapof submap_name object_name [auto [layout [background-image]]]
copy symbol_name|″ submap_name|″ submap_name
move symbol_name submap_name submap_name
sort submap_name [keys]
getlabel object_name
add symbol_name symbol_type
  [x y]
  [label symbol_label]
  [submap submap_name]
  [exec appl_name action_name]
de symbol_name
connect symbol_name symbol_name
  [name conn_symbol_name]
  [label symbol_label]
  [submap submap_name]
  [auto label]
  [auto submap]
meta symbol_name symbol_name
  [name conn_symbol_name conn_symbol_name]
  [label symbol_label symbol_label]
  [submap submap_name submap_name]
  [auto label]
  [auto submap]
set symbol_name status
assoc object_name field_name [field_value]
delobj object_name
cloneseg network_name segment_number

Figure 93 (Part 1 of 4). Summary of wtdriver6/wteuiap6 Functions
- Note:
  keys are:
  l - symbol label
  t - symbol type
  s - symbol status
  o - object status
  c - compound status

  some symbol types are: mf for "Computer:Main Frame"
  ws for "Computer:Workstation"
  cr for "Connector:Multi-port"
  ap for "Software:License"
  ss for "Software:Process"

  [ If you want to check for the abbreviation table, ]
  [ edit wteuiap6.c and search for symabbrev ]

  or anything valid in \usr\OV\symbols\C
  such as from: \usr\OV\symbols\C\Cards
    "Cards:Audio"
    "Cards:Video"
    "Cards:Thin LAN"

  another example, from:
    \usr\OV\symbols\C\Server
    "Server:File System"

  set status may be: unknown
                   normal
                   marginal
                   critical
                   acknowledge
                   up
                   down

Figure 93 (Part 2 of 4). Summary of wtdriver6/wteuiap6 Functions
Some User-defined fields are:

```c
*****
* Field Registration file for wteuiap6
* isUP field for application identify the component is UP or Down
*****/
Field "Software Status" {
    Type StringType;
    Flags locate;
}
Field "isMQSeries" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isChannel" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isQueue" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isQueueMgr" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isApplication" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "IDNX_Field_One" {
    Type StringType;
    Flags locate;
}
Field "IDNX_Field_Two" {
    Type StringType;
    Flags locate;
}
Field "WT Merge Id" {
    Type StringType;
    Flags locate;
}
Field "Some Integer" {
    Type Integer32;
    Flags locate;
}
Field "Some String" {
    Type StringType;
    Flags locate;
}
```

Figure 93 (Part 3 of 4). Summary of wtdriver6/wteuiap6 Functions
- The wteuiap6 registration file (in \usr\OV\registration\C) is:
  (This is used at EUI initiation time)

    /*
    Registration for OVw API sample application WTEUIAP6
    @(#$Revision: 1.9 $ $Date: 1994/08/30 21:13:31 $ 
    */

    Application "OVw API Example WTEUIAP6"
    {
      // wteuiap6 resided in the path \usr\OV\raleigh\wteuiap6
      // it will be initiated after NV/NT is running.

      Command -Initial -Shared -Restart "/usr/OV/raleigh/wteuiap6";
    }

7. The wtpbxd registration (in \usr\OV\lrf) is:
   (This is used at ovstart initiation time)
   wtpbxd:/usr/OV/raleigh/wtpbxd:
   OVw_YES_START:ovwdb::OVw_WELL_BEHAVED:10:

Figure 93 (Part 4 of 4). Summary of wtdriver6/wteuiap6 Functions

4.3.2 Using NetView NT EUI to Represent User Applications

Our example will demonstrate how the wteuiap6 and related utilities can be used
to manipulate the EUI from a simple Windows NT command script. Let’s
suppose we have an application where five clients are making queries against a
database. There are two copies of the database, a primary and a secondary. If
the primary server is down, the clients can use the other one. We would like a
graphical representation of this architecture, as well as a way of taking action
when a database fails. The following Windows NT command file will create a
submap depicting our application:
Rem Command script Driver6ex.cmd
Rem This script takes a NetView NT map name as a parameter.
Rem If the map is not specified the script will fail.
Rem No attempt at error checking is made.

Rem Set focus to the Root submap and create an object corresponding
Rem to the subnet that will contain our Servers and Clients
wtdriver6 -m %1 focus Root
wtdriver6 add WTD6_Example Network:Network submap

Rem Associate a contact person with our application
wtdriver6 assoc WTD6_Example "Some String" "Contact: Bonnie"

Rem Move the focus to the new submap and open it.
wtdriver6 -m %1 focus WTD6_Example
wtdriver6 -m %1 popup WTD6_Example

Rem Add the objects that will represent our servers to the map
wtdriver6 add Server1 ap submap
wtdriver6 add Server2 ap submap

Rem Associate a contact person with each of the servers
wtdriver6 assoc Server1 "Some String" "Contact: Alexander Rosenbaum"
wtdriver6 assoc Server2 "Some String" "Contact: Jane Rosenbaum"

Rem Add the objects that will represent our clients to the map
wtdriver6 add Client1 ss submap
wtdriver6 add Client2 ss submap
wtdriver6 add Client3 ss submap
wtdriver6 add Client4 ss submap
wtdriver6 add Client5 ss submap

Rem Associate a contact person with each of the clients
wtdriver6 assoc Client1 "Some String" "Contact: Yuri Bolshun"
wtdriver6 assoc Client2 "Some String" "Contact: Marina Bolshun"
wtdriver6 assoc Client3 "Some String" "Contact: Natalia Bolshun"
wtdriver6 assoc Client4 "Some String" "Contact: Lyolya Lindenbaum"
wtdriver6 assoc Client5 "Some String" "Contact: Tsylia Preston"

Rem Connect the clients to the servers
wtdriver6 connect Client1 Server1
wtdriver6 connect Client1 Server2
wtdriver6 connect Client2 Server1
wtdriver6 connect Client2 Server2
wtdriver6 connect Client3 Server1
wtdriver6 connect Client3 Server2
wtdriver6 connect Client4 Server1
wtdriver6 connect Client4 Server2
wtdriver6 connect Client5 Server1
wtdriver6 connect Client5 Server2

Figure 94. A Complete Example of User Commands for wtdriver6/wteuiap6

Executing the above command script (driver6ex.cmd <mapname>) will result in
a submap similar to the one in Figure 95 on page 122.
Now that the NetView NT is aware of our application, we can use wtdriver6.exe to manipulate the status of the new objects. We could, for example, set the status of Server1 to Critical by issuing the command:

```
wtdriver6 set Server1 critical
```

In a real production environment, we could have a process running that would monitor the health of our databases. If it found that one of the databases failed, this process could issue the appropriate wtdriver6 commands to change the status of the object representing the failed server. The process could also generate a trap using the event.exe utility supplied with the NetView NT. This trap can in turn be configured to execute some other command (run a program to dial a pager, send e-mail, execute wtdriver6, etc.).

### 4.3.3 Creating SmartSets Using Custom Fields

In the previous example we created a user-defined submap that contains some user-defined objects. We also associated a contact person with each object using a custom, user-defined field Some String. We remember that two of our contacts were Alexander and Jane Rosenbaum. We would like to group the objects for which Alexander and Jane are the contacts. We could examine each object using the GUI or ovobjprint and then copy and paste. A better and faster way is to use the SmartSets feature.
Select **Edit->Find** from the NetView NT GUI menu. When the Find dialog appears, click the **Advanced** tab. Enter the query as shown in Figure 96 on page 123 and click **OK**.

![Find dialog]

*Figure 96. Advanced Search*

The results will look similar to Figure 97 on page 124. Click **Create SmartSet** to create the collection.
Figure 97. Results of Advanced Search

Figure 98 on page 125 shows the newly created group.
4.3.3.1 NetView NT Object Structure
The above examples created a number of new NetView NT objects. Just as with any other NetView NT object, we can use the ovobjprint command or the GUI to examine our objects' structure. Figure 99 shows the structure of the Client3 object.

OBJECT: 3169

<table>
<thead>
<tr>
<th>FIELD ID</th>
<th>FIELD NAME</th>
<th>FIELD VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Selection Name</td>
<td>&quot;Client3&quot;</td>
</tr>
<tr>
<td>14</td>
<td>OVW Maps Exists</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>OVW Maps Managed</td>
<td>1</td>
</tr>
<tr>
<td>67</td>
<td>isSoftware</td>
<td>TRUE</td>
</tr>
<tr>
<td>862</td>
<td>Software Status</td>
<td>&quot;Unknown&quot;</td>
</tr>
<tr>
<td>872</td>
<td>Some String</td>
<td>&quot;Contact: Natalia Bolshun&quot;</td>
</tr>
</tbody>
</table>

Figure 99. Result of ovobjprint -s Client3
Some of the fields of Client3, such as Selection Name and isSoftware, are standard. Some String is a user-defined field. User-defined fields are created via field files stored in the \usr\ov\fields directory of your NetView NT installation. Figure 100 on page 126 shows a sample field file. Refer to NetView NT documentation for more details.

```c
Field "Software Status" {
    Type StringType;
    Flags locate;
}
Field "isMQSeries" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isChannel" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isQueue" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isQueueMgr" {
    Type Boolean;
    Flags Locate, Capability;
}
Field "isApplication" {
    Type Boolean;
}
```

Figure 100. Example of User Fields in NetView/NT

### 4.3.4 Porting User Applications from AIX to Windows NT

**Note:** All source code referred to in this book will be available after publication under the Redbooks Home Page at: http://www.redbooks.com

or from within the IBM network, Anonymous FTP server on:

```
rsserver.itso.ral.ibm.com
Directory: /pub/SG244898
```

Although The NetView/NT OVW API calls are transparent between AIX and Windows NT, in order to successfully port OVW applications from AIX to NT, a programmer must be fluent in C and have a good understanding of Berkley Sockets as well as Winsock interfaces.

#### 4.3.4.1 General Porting Issues

Porting non X-Windows applications written in C from UNIX to NT is generally a straightforward process as long as the UNIX applications do not use any UNIX specific system calls. When porting wtpbx, wtdriver6, and wteuiap6, most of the modifications were due to the compiler complaining about incompatible data types. In most cases an explicit cast took care of the problem. There were also several instances where memory allocation did not work quite right under NT and some of the header files were different.
4.3.4.2 Windows NT Console Applications

The simplest approach to porting non X-Windows applications from UNIX to NT is to build Windows NT console applications. These applications use a Command Prompt window (Windows NT console) to run in. Since no GUI specific code is required, the task of porting is much easier. The resulting code is also easily portable back to UNIX.

4.3.4.3 Windows NT Development Environment

The development environment we used to port wtpbx6, wtdriver6, and wteuiap6 was Microsoft Visual C++ (MSVC++) version 2.0. This is a fairly old version of the compiler. However, a newer version should support the project (.mak) files that we used.

When we originally developed the applications under AIX, we used make files to build them. Although it is possible to use make files with MSVC++, we found it easier to use the project feature of the MSVC++ development environment. The project definition is a file of the form <project_name.mak>. This file defines all the source and header files to be included in the project, as well as libraries, and compiler and linker settings. The development environment also automatically calculates the dependencies and pulls in the header files it needs.

4.3.4.4 Windows Sockets (Winsock)

One of the design goals for the Winsock API was to make it compatible with Berkley sockets. For the most part this goal was achieved, as long as the developer does not make use of the Windows NT extensions to Sockets. Among other things, these extensions provide a way for an application to interact with the GUI and to generate Windows NT messages (events), when data arrives and is ready to be read from the socket. Since our programs are all Windows NT console applications we did not make any attempt to use the extensions.

4.3.4.5 Machine Byte Architecture

When passing data over the network between machines of dissimilar architecture it is very important that the correct byte order be used at each end. Both Windows NT and AIX provide standard API calls to convert from host (machine) standard byte order to network standard byte order and back. If these calls are used by the original AIX application, they will be transparent when porting to Windows NT.

In the case of wtpbx6, wtdriver6, and wteuiap6, there was no attempt by the original application to preserve the correct byte order and we did not remedy this during the port. Therefore, the ported applications will communicate only between machines of similar architectures.

4.3.4.6 Winsock Initialization

Before making any Winsock calls, the library must be initialized, using the following routine:

```plaintext
returncode=WSAStartup(WSA_VERSION, &stWSAData);
```

If the initialization is successful, WSAStrartup will return zero.
4.3.4.7 Winsock Cleanup

When the socket application exits, the following routine should be used:

```c
WSACleanup();
```

The following code excerpt will convert all existing calls to exit() to include a call to WSACleanup. All references to exit() must be changed to reference a routine that includes WSACleanup. Using the following preprocessor commands, this can be done without having to modifying all references to exit() in the source code.

```c
#ifdef WINSOCK_ENABLED
void myexit(int);
#define exit myexit
#endif
```

Next, the following routine should be added somewhere in the source:

```c
void
myexit(int rc)
{
    WSACleanup();
    /* this should be the last line of the .c file */
    #undef exit
    exit(rc);
}
```

4.3.4.8 Winsock Errors

If Winsock initialization fails or one of the calls encounters a failure, the Winsock library will return a code of SOCKET_ERROR as opposed to the AIX socket library, which would return EOF. All references to socket routines that test for EOF should be changed to test for SOCKET_ERROR. The following excerpt will allow your code to be portable back to UNIX:

```c
#ifndef WINSOCK_ENABLED
#define SOCKET_ERROR EOF
#endif
```

If a call to a Winsock library routine returns SOCKET_ERROR, the following routine can be used to determine the reason for the failure:

```c
errornum=WSAGetLastError();
```

4.3.4.9 Winsock Socket Descriptors

Winsock does not use standard file descriptors for sockets as does UNIX. The data type for socket variables must be changed from int to SOCKET. Also, any references to close() must be changed to closesocket() when working with socket variables. Unfortunately there is no easy way to define your way around searching and replacing all references to int socket_fd with SOCKET socket_fd and close(socket_fd) with closesocket(socket_fd). Once you have replaced all the references however, the following preprocessor commands will insure portability back to UNIX:

```c
#ifndef WINSOCK_ENABLED
#define SOCKET int
#define socketclose close
#endif
```
4.3.4.10 NetView NuT Cracker Sockets

Previous versions of NetView NT did not use Winsock API internally. Instead they used a version of the API called NuT Cracker sockets. If an application wanted to use a socket returned by an OVW API for purposes other than communication with NetView, it was necessary to explicitly convert from NuT Cracker to Winsock using the OVFdToHandle(x) API call. Since the new version of NetView NT uses Winsock, conversion is no longer necessary.

4.3.4.11 Well-Behaved NetView/NT Daemon - wtpbx.d.c

The following code excerpt is an example of a well-behaved NetView/NT daemon that has been ported from AIX to NT. For the sake of clarity the code has been modified to include only the relevant parts. Most of the error handling has been removed.

```c
#include <stdio.h>
#include <netview.h>

void main()
{
    int OVsock;
    SOCKET OWsock;

    int DriverPort, EUIPort;
    SOCKET DriverSock, EUISock;

    /* fd_set structure is portable from UNIX */
    fd_set rdlist, wrlist, exlist;

    /* Do the Winsock init */
    #ifdef WINSOCK_ENABLED
    InitWinSock();
    #endif

    /* establish socket connection to NetView */
    OVsock=OVsInit(&OVsock);

    /* convert NuT Cracker/NetView socket to Winsock socket if necessary */
    /* OVsock=OVFdToHandle(OVsock); Conversion no longer necessary! */
    OWsock=(SOCKET)OVsock;

    DriverPort=ServiceByName(PBXDRIVER_WK_NAME, "udp", PBXDRIVER_WK_PORT);
    DriverSock=SockFixBind(SOCK_DGRAM, DriverPort);

    EUIPort=ServiceByName(PBXEUI_WK_NAME, "udp", PBXEUI_WK_PORT);
    EUISock=SockFixBind(SOCK_DGRAM, EUIPort);

    /* Init NetView database */
    OVwDbInit();

    /* This is a well-behaved deamon */
    OVsockComplete(OVS_RSP_SUCCESS, "Initialization complete.");

    /* Except for error handling, the body of the while(1)
     * loop has been unchanged from UNIX to NT.
     */

    while(1)
    {
```
Listen to:
The OVsSock socket (ovspmd commands)
The DriverSock socket, (sic commands)
The EUISock socket, (sic responses)
*/

int s;
FD_ZERO(&rdlist);
FD_SET(DriverSock, &rdlist);
FD_SET(EUISock, &rdlist);
FD_SET(OVwinSock, &rdlist);
s=select(32,&rdlist,NULL,NULL,NULL);
switch(NFDS(s))
{
case 0;/* stopped with unknown condition */
case NFDS(-1);;/* stopped with unknown condition */
case SOCKET_ERROR;;/* returned socket error - try again */
ifdef WINSOCK_ENABLED
errornum=WSAGetLastError();
printf("select error=%d, hex=%x\n",errornum,errornum);
#else
printf("select error=%d\n",errno);
#endif
/* continue while(1) */
continue;

default:
break;
}

/* this is regular socket status testing */
if(FD_ISSET(DriverSock, &rdlist)) /* process received data */
sockrcv_PDU(DriverSock, DriverPort, NULL);
if(FD_ISSET(EUISock, &rdlist)) /* process received data */
sockrcv_PDU(EUISock, EUIPort, NULL);
if(FD_ISSET(OVwinSock, &rdlist)) /* process received data */
sockrcv_OVs(OVsSock, NULL);
} /* while(1) */
} /* main() */
Appendix A. TME 10 NetView Web Interface - README (Jan. 1997)

Please read the LICENSE.HTML before using this program.
Note: This is pre-release prototype code; it is unsupported at the current time and should not be installed in a production environment.

Sites with NetView security enabled should not install this code as it currently ignores NetView security settings.

Please read the following, especially known bugs and limitations:

Installation

This section applies only to users that download the Web add-on package separately. If you have received this as part of the TME10 NetView 5.0 distribution, installation and configuration of the Web interface is done as part of the main NetView installation.

Exit the NetView user interface

Leave the NetView daemons running

Uncompress and untar the distribution file

Configuration

The NetView daemons must be running before you do this

In order to use Cooltalk, you should place strings of the form:
CoolTalk: user@node;
in the sysContact field of your SNMP agents.

The semicolons are required (sorry about that, we haven’t written a real parser yet).
This will also be the same format for pager links in the future, i.e.;Pager: pagerNumber;

Install the Web code on the other NetViews in your network if you wish to be able to switch to them (again, do not install this code on any production systems)

Startup and Use

As root, run /usr/OV/Web/httpd/NetViewWebServer (This is primarily for users that have installed the add-on; it is run automatically from the nv6000 startup script in TME10 NetView 5.0)

The Web interface is now running at port 8008; point your browser to http://YourMachinesFullIPAddress:8008 in order to access NetView.

Currently security is enabled but not configured (we plan to integrate this with the current NetView security mechanisms in the production version). When prompted, enter user ID <tt>demo</tt> and enter an Internet e-mail address as a password (e.g. <tt>me@corp.com</tt>).
As root, restart the NetView user interface

In order to view submaps from the Web, the NetView user interface must be running with a map in read-write mode.

Note that when viewing the submaps, the icons and the labels on the icons are usually different links; clicking on the icon goes into the lower level submap, whereas clicking on its label brings up NetView information about that resource, including diagnostics for icons which represent managed nodes such as routers.

Change History

9 December 1996

Removed blinking text from README file and added "Enter" link on title page.

Added information to README file since this is now also available as part of the TME10 NetView 5.0 beta package rather than just a downloadable add-on.

Removed warning panel from document root in beta package; this will still be the first panel in the download package.

25 October 1996

Added warning panel to document root at request of service so people don’t call service for bugs on the Web interface.

16 October 1996

Fixed bug in Dynamic Events->Show Node caused by change in format of the query string required by ObjectInfoByID.

11 October 1996

Directory information (formatted index returned when URL is a directory) changed to display information in a table.

9 October 1996

Successfully avoiding the GIF generator...

Added Field information icon to General Diagnostics panel. nvHtmlInfo tries first as a selection name, then as a fully qualified hostname (as stored in the database), and then does name resolution to get a fully qualified hostname which it runs against the database again.

8 October 1996

MIB Applications should work now even if DisplayString fields retrieved from an agent contain quotes or newlines.

7 October 1996

Made mibform (SNMP form applications) also use table display
Chopped off first two columns on events-by-node display
Made NetView daemon status refresh once per minute

6 October 1996

Reorganized field information display; fields are now displayed in order:
Name and "Locate" fields
Capabilities (enumerated, true, then false)
All others

Made modifications to nvHtmlInfo

New option "f" to display field information to support above
Added options to subroutines to fix up field output so possible
to use in JavaScript or straight HTML.
New "processField" subroutine to handle nicer formatting (as in
nnmHtml.C)

Need to propagate this output format spec to other options

5 October 1996
Modified Apache /status and /info pages

Added compilation date and time to /info
Added resource usage (from getrusage() call) to /status

Modified Ping to use record route option by default
Added support for multiple maps to contents page

Added undocument options to ovmapdump

ovmapdump -outstring where outstring should be a
printf string of the form "%s, %s, %s, %s": the first four arguments
correspond to map name, permissions, creation time, comments, and the
last is <tt>true</tt> if there is a Web query server running for that map
(otherwise it is <tt>false</tt>).

ovmapdump -a -outstring as above, but only prints
information about maps with active Web query servers.

4 October 1996

Added ability to switch between managers to table of contents and
to bottom menubar

Assumes the "NetViews" collection has been set up
All "NetViews" must have the Web server installed (obviously) and
running at the same port

Added multiple map support to map views

Have not added way to switch between maps to contents or menu yet

29 September 1996

Upgraded Webquery and queryclient

queryclient now requires map name and command to be passed to
Webquery
Webquery now has class-based command handler, created in factory
method for query handler
New commands include Broadcast, Exit, Touch, and SubmapSymbols;
the last is what is used in the current map views to obtain live data
Changed maps to use TME10.NetView.Monitor.Maps, which has a hack for the new queryclient (map name hardcoded)
Added README and LICENSE to home page
Added enhancement candidates to README

24 September 1996
Fixed bug in sorting tables when cells were not filled in
Fixed bug in output of TCP/UDP Sockets (linefeed in middle of JavaScript string caused error). This was changed in rnetstat
Modified rnetstat and mibtable to not spit out so much empty space for HTML formatted output
Made process-mibappl faster by assigning vars to parent.MakeRow and parent.AddCell so each element add only requires a 1-letter function name

23 September 1996
Sorting now works on IP addresses, fakely
(SNMP apps not passing column data type through yet)
Physical addresses still being sorted as a string
Moved correct rnetstat (with HTML support) into tree, modified process-mibappl to use the right one (under TME10_NetView_Binaries)

22 September 1996
Tables (MIB Applications, list of collections, etc.) are now sortable, on Netscapes which support JavaScript 1.1 Arrays properly.
This includes the Windows 95/NT versions of Netscape 3.0
This does not include Netscape 3.0 on AIX, unfortunately
Fixed bug where map would not show up until you changed an option

21 September 1996
Created new title graphic
Added MIDI mime type to server
Added MIDI background music to title

20 September 1996
Added button to select sets of statuses on maps
Added total of nodes with selected statuses

18 September 1996
Removed Close button.
Aligned bottom menu images with bottom of line, freeing up more space on top

17 September 1996
Added Close button to menubar to close current window
Moved Tivoli logo on menubar away from others
Modified title on maps so that each portion of the path to the current map is now a link back to that component higher up in the hierarchy
Modified links to collections in collection list so that they now replace the current window by default rather than bringing up a new window. User can return by clicking on the title of the contents window.
Made Web code more self contained:

- Added SetEnv directive in srm.conf to set NVWEBBINARIES to /usr/OV/Web/httpd/cgi-bin/TME10_NetView_Binaries; this environment variable is available to cgi-bin scripts
- Moved all binaries from /usr/OV/bin and /usr/OV/Web/httpd/cgi-bin to $NVWEBBINARIES
- Modified cgi-bin scripts to use this variable rather than hardcoding a path

16 September 1996

Dynamic status changes now working!

You can actually see icons change color before your very eyes!

15 September 1996

Sped up map display by using real Arrays to store symbols; major speed improvement for screens with lots (several hundred) of nodes.
- Added animated Ping icon!
- Fixed problems with generic diagnostics not picking up right node name from entry panel
- Removed node name and community name entry fields from MIB Applications panel when displayed under specific diagnostics
- More panel resizing and adjustments for 800x600
- Removed sort capability from Collections list - not working under AIX. Works on Windows 95, need to put back for Windows 95 Netscape.

14 September 1996

Redesigned most panels to fit in 800x600
- Modified collection contents view to use map display (icons rather than listing)
- Added SMappl icons

Known Bugs

- Apparently, ovw must be run by root in order to view maps.
- GIF files are not generated automatically at this time for all registered symbols; they must be created manually.
- Map name in use not kept up with in all panels
- All NetViews detected (isManager=true) are assumed to be running the Web server and are placed in the manager selection list
- No error message if an attempt is made to view a map which does not have a map server running
- Dynamic events display sometimes gets selections confused
Generated SNMP Applications with spaces in the name will break the MIB applications page.
getusage() information on the server /status page is returned by a random child rather than the parent server, and is thus not as useful as it could be.

Known Limitations

The machine you run this on must have a hostname.
Leaving a dynamic map page kills it; on return it looks the same but it is not receiving updates.

Enhancements

The following is a list of candidates for enhancements to the Web interface; those with target dates are already planned, the others are candidates. This list does not include:

General optimization for reducing browser-server traffic or processing on the browser and server; such optimization will take place during beta test as time allows.
Planned work on meeting user requests obtained during alpha and beta test periods
Phase 2 work, currently still Tivoli Confidential
Appendix B. Miscellaneous AIX MAN Entries

The following AIX MAN entries are placed here for the convenience of the readers of this document. Please refer to online AIX MAN entries for the latest information.

B.1 nvUtil

nvUtil(1)

Purpose
Enables you to create, modify, and delete collections of objects

Syntax
nvUtil option required_parameters [additional_parameters]

Description
The /usr/OV/bin/nvUtil command is the command line interface to the Collection Facility.

Parameters
The following list summarizes the valid values for option. Parameters not within brackets ([ ]) are required; parameters within brackets ([ ]) are optional.

L Lists all collections
G [printfstring(%s,%d,%s,%s) name, size, description, rule] Gets all collections and rules
g name Gets the description and rule for the specified collection
l name [outstring] Lists members of the specified collection
e rule [outstring] Evaluates the specified rule
p rule Evaluates the specified rule and prints the field values
a name desc rule [force] Adds a new collection with the specified name,
description, rule

D name [force]
   Deletes the specified collection

X
   Deletes all collections

d name desc
   Modifies the description of the specified collection

r name rule
   Modifies the rule of the specified collection

m name desc rule
   Modifies the description and rule of the specified collection

s oid
   Shows all collections containing the specified object ID

u name1 name2 [outstring]
   Joins the two specified collections together using the logical OR (union) operator

c name oid
   Joins the specified collection and the specified object ID together using the logical OR (union) operator

i name1 name2 [outstring]
   Joins the specified collections together using the logical AND (intersect) operator

t name oid
   Joins the specified collection and object ID together using the logical AND (intersect) operator

n SelectionName [outstring]
   Specifies object field information for the selection name of an object from the object database

o oid [outstring]
   Specifies object field information for the object ID of an object from the object database

f SelectionName OrderString
   Specifies object field information for the specified selection name, where OrderString is the letters NETFLG corresponding to the first letter of each of the followingFmt strings in the preferred order: nameFmt, enumCapFmt, trueCapFmt, falseCapFmt, locateFmt, and generalFmt.

The following is a description of the required and additional parameters:

name   The name of the collection.
desc   The description of the collection.
rule   The rule for the collection.
force Force the operation to occur even if dependencies exist. The value can be 0 or 1.

oid The object ID of an object from the object database.

SelectionName The Selection Name of an object from the object database.

outstring A string in which substring of the form: %<fieldname>% will be replaced by the value of the field. For example, %Selection Name% is replaced by the selection name for every object in the specified list of objects. %OBJECT ID% will be replaced with the object’s owxdb object ID.

printfstring(x) A printf-style string where x indicates fixed parameters

Fmt A field format specification (nameFmt, enumCapFmt, trueCapFmt, falseCapFmt, locateFmt, and generalFmt) of the form:

tableTag,fieldTag,IDtag,NameTag,DataTag,ElementData

Where each tag has the form BEGIN%sEND; the BEGIN and END strings are printed before and after the actual data in the tag. The ElementData tag is used only for fields which are lists; in this case the DataTag wraps around the entire field, and the ElementData tag wraps around each member of the list. The ElementData tag can be used with the TME 10 NetView web interface.

Examples

The following command creates a collection named, CriticalRouters, which consists of all IBM routers and all Cisco Systems routers whose IP status is critical:

```
  nvUtil "Critical Routers" "All critical routers" "vendor=IBM" || \n  "vendor=ciscoSystems" && "isRouter=True" && "IP Status=Critical"
```

The following command lists the names all existing collections:

```
  nvUtil L
```

Implementation Specifics

The environment variable LANG determines the language in which messages are displayed. If LANG is not specified, or is set to the empty string, the default C is used instead of LANG.

The nvUtil command supports single-byte and multibyte character
code sets.

Related Information

See the description of the Collection Facility in the TME 10 NetView Administrator's Guide.
regcmp or regex Subroutine

Purpose

Compiles and matches regular-expression patterns.

Library

Programmers Workbench Library (libPW.a)

Syntax

char *regcmp (String [, String, . . . ], (char *) 0)
char *String, . . . ;

char *regex (Pattern, Subject [, ret, . . . ])
char *Pattern, *Subject, *ret, . . . ;
extern char *__loc1;

Description

The regcmp subroutine compiles a regular expression (or Pattern) and returns a pointer to the compiled form. The regcmp subroutine allows multiple String parameters. If more than one String parameter is given, then the regcmp subroutine treats them as if they were concatenated together. It returns a NULL pointer if it encounters an incorrect parameter.

You can use the regcmp command to compile regular expressions into your C program, frequently eliminating the need to call the regcmp subroutine at run time.

The regex subroutine compares a compiled Pattern to the Subject string. Additional parameters are used to receive values. Upon successful completion, the regex subroutine returns a pointer to the next unmatched character. If the regex subroutine fails, a NULL pointer is returned. A global character pointer, __loc1, points to where the match began.

The regcmp and regex subroutines are borrowed from the ed command; however, the syntax and semantics have been changed slightly. You can use the following symbols with the regcmp and regex subroutines:

[ ] * . \[ These symbols have the same meaning as they do in the ed command.

- The minus sign (or hyphen) within brackets used with the regex subroutine means "through," according to the current collating sequence. For example, [a-z] can be equivalent to [abcd . . . xyz] or [aBbCc . . . xYyZz]. You can use the - by itself if the - is the last or first character. For example, the character class expression [ ] -] matches
The regcmp subroutine does not use the current collating se-
quence, and the minus character in brackets controls only a
direct ASCII sequence. For example, \[a-z\] always means
\[abc . . . xyz\] and \[A-Z\]
always means \[ABC . . . XYZ\]. If you
need to control the specific characters in a range using the
regcmp subroutine, you must list them explicitly rather than us-
ing the minus in the character class expression.

$ Matches the end of the string. Use \n to match a new-line
character.

+ A regular expression followed by + (plus sign) means one or
more times. For example, \[0-9\] + is equivalent
to \[0-9\] \[0-9\] *.

\[ m\] \[ m,\] \[ m, u\]
Integer values enclosed in [] (brackets) indi-
cate the number of times to apply the preceding regular expres-
sion. m is the minimum number and u is the maximum
number. u must be less than 256. If you specify only m, it indi-
cates the exact number of times to apply the regular expression.
\[m,\] is equivalent to
\[m,u.\] and matches m or more occurrences of
the expression. The plus + (plus) and * (asterisk) operations
are equivalent to \[1,\] and \[0,\] , respectively.

( . . . )\$n This stores the value matched by the enclosed regular
expression in the (n+1)th ret parameter. Ten enclosed regular
expressions are allowed. The regex subroutine makes the assign-
ments unconditionally.

( . . . ) Parentheses group subexpressions. An operator, such as
*, +, or [] works on a single
character or on a regular expres-
sion enclosed in parentheses. For example, \(a*(cb+)*\)\$0.

All of the preceding defined symbols are special. You must pre-
cede them with a \ (backslash) if you want to match the special
symbol itself. For example, $ matches a dollar sign.

Note: The regcmp subroutine uses the malloc subroutine to make
the space for the vector. Always free the vectors that are not
required. If you do not free the unneeded vectors, you can run
out of memory if the regcmp subroutine is called repeatedly. Use
the following as a replacement for the malloc subroutine to reuse
the same vector, thus saving time and space:

/* . . . Your Program . . . */
malloc(n)

int n;
{
    static int rebuf[256];
    return ((n <= sizeof(rebuf)) ? rebuf : NULL);
}

The regcmp subroutine produces code values that the regex subrou-
tine can interpret as the regular expression. For instance, \[a-z\] indicates a range expression which the regcmp subroutine compiles into a string containing the two end points (a and z).

The regex subroutine interprets the range statement according to the current collating sequence.

The expression \[a-z\] can be equivalent either to \[abcd . . . xyz\], or to \[aBbCcDd . . . xXyYzZ\], as long as the character preceding the minus sign has a lower collating value than the character following the minus sign.

The behavior of a range expression is dependent on the collation sequence. If you want to match a specific set of characters, you should list each one. For example, to select letters a, b, or c, use \[abc\] rather than \[a-c\].

Notes:

1. No assumptions are made at compile time about the actual characters contained in the range.

2. Do not use multi-byte characters.

3. You can use the \] (right bracket) itself within a pair of brackets if it immediately follows the leading \[ (left bracket) or \[\ (a left bracket followed immediately by a circumflex).

4. You can also use the minus sign (or hyphen) if it is the first or last character in the expression. For example, the expression \[ -0\] matches either the right bracket \], or the characters - through 0.

Matching a Character Class in National Language Support

A common use of the range expression is matching a character class. For example, \[0-9\] represents all digits, and \[a-z, A-Z\] represents all letters. This form may produce unexpected results when ranges are interpreted according to the current collating sequence.

Instead of the range expression shown above, use a character class expression within brackets to match characters. The system interprets this type of expression according to the current character class definition. However, you cannot use character class expressions in range expressions.

The following exemplifies the syntax of a character class expression:

\[:charclass:]$

that is, a left bracket followed by a colon, followed by the name of the character class, followed by another colon and a right bracket.
National Language Support supports the following character classes:

[:upper:]  ASCII uppercase letters.
[:lower:]  ASCII lowercase letters.
[:alpha:]  ASCII uppercase and lowercase letters.
[:digit:]  ASCII digits.
[:alnum:]  ASCII uppercase and lowercase letters, and digits
[:xdigit:]  ASCII hexadecimal digits.
[:punct:]  ASCII punctuation character (neither a control character nor an alphanumerical character).
[:space:]  ASCII space, tab, carriage return, new-line, vertical tab, or form feed character.
[:print:]  ASCII printing characters.

Parameters

Subject  Specifies a comparison string.
String  Specifies the Pattern to be compiled.
Pattern  Specifies the expression to be compared.
ret  Points to an address at which to store comparison data. The regex subroutine allows multiple ret String parameters.

Implementation Specifics

These subroutines are part of Base Operating System (BOS) Runtime.

Suggested Reading

Prerequisite Information

Subroutines Overview in General Programming Concepts.

Related Information

The ctype subroutine, compile, step, or advance subroutine, malloc, free, realloc, calloc, mallopt, mallinfo, or alloca subroutine, regcomp, regex subroutine.

The ed command, regcmp command.
Appendix C. Special Notices

This publication is intended to help persons involved with TME 10 NetView. The information in this publication is not intended as the specification of any programming interfaces that are provided by TME 10 NetView. See the PUBLICATIONS section of the IBM Programming Announcement for TME 10 NetView for more information about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM’s intellectual property rights may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact IBM Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The information about non-IBM (“vendor”) products in this manual has been supplied by the vendor and IBM assumes no responsibility for its accuracy or completeness. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

Any performance data contained in this document was determined in a controlled environment, and therefore, the results that may be obtained in other operating environments may vary significantly. Users of this document should verify the applicable data for their specific environment.

Reference to PTF numbers that have not been released through the normal distribution process does not imply general availability. The purpose of including these reference numbers is to alert IBM customers to specific
information relative to the implementation of the PTF when it becomes available to each customer according to the normal IBM PTF distribution process.

The following terms are trademarks of the International Business Machines Corporation in the United States and/or other countries:

<table>
<thead>
<tr>
<th>Term</th>
<th>Trademark</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>AIX/6000</td>
</tr>
<tr>
<td>CICS</td>
<td>IBM</td>
</tr>
<tr>
<td>IMS</td>
<td>MQ</td>
</tr>
<tr>
<td>MQSeries</td>
<td>MVS/ESA</td>
</tr>
<tr>
<td>NetView</td>
<td>Nways</td>
</tr>
<tr>
<td>RACF</td>
<td>RETAIN</td>
</tr>
<tr>
<td>RMF</td>
<td>RS/6000</td>
</tr>
<tr>
<td>SAA</td>
<td>SP</td>
</tr>
<tr>
<td>Trouble Ticket</td>
<td>VTAM</td>
</tr>
</tbody>
</table>

The following terms are trademarks of other companies:

C-bus is a trademark of Corollary, Inc.

Java and HotJava are trademarks of Sun Microsystems, Incorporated.

Microsoft, Windows, Windows NT, and the Windows 95 logo are trademarks or registered trademarks of Microsoft Corporation.

PC Direct is a trademark of Ziff Communications Company and is used by IBM Corporation under license.

Pentium, MMX, ProShare, LANDesk, and ActionMedia are trademarks or registered trademarks of Intel Corporation in the U.S. and other countries.

UNIX is a registered trademark in the United States and other countries licensed exclusively through X/Open Company Limited.

Other company, product, and service names may be trademarks or service marks of others.

<table>
<thead>
<tr>
<th>Term</th>
<th>Trademark</th>
</tr>
</thead>
<tbody>
<tr>
<td>C++</td>
<td>American Telephone and Telegraph Company, Incorporated</td>
</tr>
<tr>
<td>CSA</td>
<td>Canadian Standards Association</td>
</tr>
<tr>
<td>DEC</td>
<td>Digital Equipment Corporation</td>
</tr>
<tr>
<td>Digital</td>
<td>Digital Equipment Corporation</td>
</tr>
<tr>
<td>Netscape</td>
<td>Netscape Communications Corporation</td>
</tr>
<tr>
<td>NFS</td>
<td>Sun Microsystems Incorporated</td>
</tr>
<tr>
<td>POLYCENTER</td>
<td>Digital Equipment Corporation</td>
</tr>
<tr>
<td>PowerPoint</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>SAM</td>
<td>Symantec Corporation</td>
</tr>
<tr>
<td>Solaris</td>
<td>Sun Microsystems, Incorporated</td>
</tr>
<tr>
<td>Tivoli Management Framework</td>
<td>Tivoli Systems Inc., an IBM Company</td>
</tr>
<tr>
<td>Tivoli/Enterprise Console</td>
<td>Tivoli Systems Inc., an IBM Company</td>
</tr>
</tbody>
</table>
Appendix D. Related Publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

D.1 International Technical Support Organization Publications

For information on ordering these ITSO publications see “How to Get ITSO Redbooks” on page 149.

- TME 10 Cookbook for AIX Systems Management and Networking Applications, SG24-4867
- Examples of Using NetView for AIX Version 4, SG24-4515
- Examples of Using NetView for AIX (V3), GG24-4327

D.2 Redbooks on CD-ROMs

Redbooks are also available on CD-ROMs. Order a subscription and receive updates 2-4 times a year at significant savings.

<table>
<thead>
<tr>
<th>CD-ROM Title</th>
<th>Subscription Number</th>
<th>Collection Kit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>System/390 Redbooks Collection</td>
<td>SBOF-7201</td>
<td>SK2T-2177</td>
</tr>
<tr>
<td>Networking and Systems Management Redbooks Collection</td>
<td>SBOF-7370</td>
<td>SK2T-6022</td>
</tr>
<tr>
<td>Transaction Processing and Data Management Redbook</td>
<td>SBOF-7240</td>
<td>SK2T-8038</td>
</tr>
<tr>
<td>AS/400 Redbooks Collection</td>
<td>SBOF-7270</td>
<td>SK2T-2849</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (HTML, BkMgr)</td>
<td>SBOF-7230</td>
<td>SK2T-8040</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (PostScript)</td>
<td>SBOF-7205</td>
<td>SK2T-8041</td>
</tr>
<tr>
<td>Application Development Redbooks Collection</td>
<td>SBOF-7290</td>
<td>SK2T-8037</td>
</tr>
<tr>
<td>Personal Systems Redbooks Collection</td>
<td>SBOF-7250</td>
<td>SK2T-8042</td>
</tr>
</tbody>
</table>

D.3 Other Publications

These publications are also relevant as further information sources:

- NetView for AIX Programmer’s Guide, SC31-8164
- NetView for AIX Programmer’s Reference, SC31-8165
- TME 10 NetView for Windows NT User’s Guide, GC31-8415
- TME 10 NetView for Windows NT Programmer’s Reference, SC31-8417
How to Get ITSO Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, CD-ROMs, workshops, and residencies. A form for ordering books and CD-ROMs is also provided.

This information was current at the time of publication, but is continually subject to change. The latest information may be found at URL http://www.redbooks.ibm.com.

How IBM Employees Can Get ITSO Redbooks

Employees may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **PUBORDER** — to order hardcopies in United States
- **GOPHER** link to the Internet - type GOPHER.WTSCPOK.ITSO.IBM.COM
- **Tools disks**
  To get LIST3820s of redbooks, type one of the following commands:
  TOOLS SENDTO EHONE4 TOOLS2 REDPRINT GET SG24xxxx PACKAGE
  TOOLS SENDTO CANVM2 TOOLS REDPRINT GET SG24xxxx PACKAGE (Canadian users only)
  To get BookManager BOOKs of redbooks, type the following command:
  TOOLCAT REDBOOKS
  To get lists of redbooks:
  TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET ITSOCAT TXT
  TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET LISTSERV PACKAGE
  To register for information on workshops, residencies, and redbooks:
  TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ITSOREGI 1996
  For a list of product area specialists in the ITSO:
  TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ORGCARD PACKAGE
- **Redbooks Home Page on the World Wide Web**
  http://w3.itso.ibm.com/redbooks
- **IBM Direct Publications Catalog on the World Wide Web**
  IBM employees may obtain LIST3820s of redbooks from this page.
- **REDBOOKS category on INEWS**
- **Online** — send orders to: USIB6FPL at IBMMAIL or DKIBMBSH at IBMMAIL
- **Internet Listserver**
  With an Internet e-mail address, anyone can subscribe to an IBM Announcement Listserver. To initiate the service, send an e-mail note to announce@webster.ibm.com with the keyword subscribe in the body of the note (leave the subject line blank). A category form and detailed instructions will be sent to you.
# How Customers Can Get ITSO Redbooks

Customers may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **Online Orders** (Do not send credit card information over the Internet) — send orders to:

<table>
<thead>
<tr>
<th>In United States:</th>
<th>IBMMAIL</th>
<th>Internet</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>usib6ipl at ibmmail</td>
<td><a href="mailto:usib6ipl@ibmmail.com">usib6ipl@ibmmail.com</a></td>
</tr>
<tr>
<td>In Canada:</td>
<td>caibmbkz at ibmmail</td>
<td><a href="mailto:lmannix@vnet.ibm.com">lmannix@vnet.ibm.com</a></td>
</tr>
<tr>
<td>Outside North America:</td>
<td>dkibmbsh at ibmmail</td>
<td><a href="mailto:bookshop@dk.ibm.com">bookshop@dk.ibm.com</a></td>
</tr>
</tbody>
</table>

- **Telephone orders**
  - United States (toll free) 1-800-879-2755
  - Canada (toll free) 1-800-IBM-4YOU
  - Outside North America (long distance charges apply)
    - (+45) 4810-1320 - Danish
    - (+45) 4810-1420 - Dutch
    - (+45) 4810-1540 - English
    - (+45) 4810-1670 - Finnish
    - (+45) 4810-1220 - French
    - (+45) 4810-1020 - German
    - (+45) 4810-1620 - Italian
    - (+45) 4810-1270 - Norwegian
    - (+45) 4810-1120 - Spanish
    - (+45) 4810-1170 - Swedish

- **Mail Orders** — send orders to:

<table>
<thead>
<tr>
<th>IBM Publications</th>
<th>IBM Publications</th>
<th>IBM Direct Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publications Customer Support</td>
<td>144-4th Avenue, S.W.</td>
<td>Sortemosevej 21</td>
</tr>
<tr>
<td>P.O. Box 29570</td>
<td>Calgary, Alberta T2P 3N5</td>
<td>DK-3450 Allerød</td>
</tr>
<tr>
<td>Raleigh, NC 27626-0570</td>
<td>Canada</td>
<td>Denmark</td>
</tr>
<tr>
<td>USA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Fax** — send orders to:
  - United States (toll free) 1-800-445-9269
  - Canada 1-403-267-4455
  - Outside North America (+45) 48 14 2207 (long distance charge)

- **1-800-IBM-4FAX (United States)** or (**1)001-408-256-5422 (Outside USA)** — ask for:
  - Index # 4421 Abstracts of new redbooks
  - Index # 4422 IBM redbooks
  - Index # 4420 Redbooks for last six months

- **Direct Services** - send note to softwareshop@vnet.ibm.com

- **On the World Wide Web**
  - IBM Publications Customer Support redbooks.ibm.com
  - IBM Direct Publications Catalog elink.ibmlink.ibm.com/pbl/pbl

- **Internet Listserver**
  With an Internet e-mail address, anyone can subscribe to an IBM Announcement Listserver. To initiate the service, send an e-mail note to announce@webster.ibmlink.ibm.com with the keyword subscribe in the body of the note (leave the subject line blank).
IBM Redbook Order Form

Please send me the following:

<table>
<thead>
<tr>
<th>Title</th>
<th>Order Number</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

First name  Last name

Company

Address

City  Postal code  Country

Telephone number  Telefax number  VAT number

- Invoice to customer number
- Credit card number

Credit card expiration date  Card issued to  Signature

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not available in all countries. Signature mandatory for credit card payment.

DO NOT SEND CREDIT CARD INFORMATION OVER THE INTERNET.
Index

A
appmon 108

B
bibliography 147

C
community 94, 98
community name 81
console applications 127

d
daemon 83, 88

E
Enterprise 105, 106
event 103
event -d “some comment” 105
event.exe 105

F
FAQ 97
field 101
field_id 101
fields 126

G
graphical user interface 83
GUI 83, 85, 87

I
Installation Log 97
Installation Manager 97
interval 93

L
log files 96

M
Map 85
MIB Browser 97

N
netmon 84
NetView Help 97

NetView NuT Cracker Sockets 129
NetView Setup 97
NetView/NT Event Browser 97

O
object database 100
Object Properties 102
object_id 101
Online Books 97
ovobjprint 100
ovtopmd 85
ovw 126

P
paging space 75
poll 90, 91
polling 94
porting 126
Prerequisites 75
Process Viewer 97

S
Server Status 97
SNMP 77
SNMP Agent 78
SNMP Security 81
SNMP Services 78
snmpset 99
sockets 128
Start Server 97
status polling 91
Stop Server 97

T
TME 10 NetView Console 97
Trap 105
trap destinations 80
trapd 84

U
UNIX Makefiles 127

W
well-behaved 129
Winsock 127
wtdriver6/wteuiap6 functions 117
wtdriver6/wtpbx6/wteuiap6 116

© Copyright IBM Corp. 1996 1997
ITSO Redbook Evaluation

Examples of Using TME 10 NetView for AIX V5 and SG24-4898-01

Your feedback is very important to help us maintain the quality of ITSO redbooks. Please complete this questionnaire and return it using one of the following methods:

• Use the online evaluation form found at http://www.redbooks.com
• Fax this form to: USA International Access Code + 1 914 432 8264
• Send your comments in an Internet note to redeval@vnet.ibm.com

Please rate your overall satisfaction with this book using the scale:
(1 = very good, 2 = good, 3 = average, 4 = poor, 5 = very poor)

Overall Satisfaction ____________

Please answer the following questions:

Was this redbook published in time for your needs? Yes___ No___
If no, please explain:
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________

What other redbooks would you like to see published?
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________

Comments/Suggestions: (THANK YOU FOR YOUR FEEDBACK!)
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________
_____________________________________________________________________________________________________